
Mixcraft™ 2.0 Overview
Mixcraft™ is a multitrack audio recording studio with effects, featuring Reverb, Delay/Echo, EQ, 
Compression, Flanger, Distortion and Chorus, as well as resonant filters and a powerful loop editor.  
The high performance 32 bit sound engine supports broadcast quality WAV files and will even import 
compressed MP3, OGG & WMA files.  Use it to record your own music, your band or even a remix for a 
dance recital.  The amazing fact about home recording today is that you really only need a computer 
and a good multitrack recording program such as Mixcraft to create amazing sound!  When you’ve 
finished your mix, publish it to the Internet as an MP3, OGG, WMA or RealAudio file, or burn it to a CD.

Unleash your creative side!
Using your computer's microphone or an external hardware mixer, you can record your own voice, 
guitars, drums or your kid*. (*Assumes you have a kid.  Doesn’t everyone? ;-)) 

Who can use it ?
DJs, pro and amateur musicians, bands, practicing singers, radio people, webmasters, professors, 
teachers, students, employees, dance studios, gym & spinning instructors, game designers, movie 
makers, sound designers and the list goes on!

What can you use it for?
Recording music, converting your LPs and cassettes into CDs or MP3s, recording a DJ dance mix, 
creating a mix for a dance recital, creating a presentation for your company, creating a work out mix, 
recording your own audio book, creating a funny off the wall answering machine message, creating audio 
homework, splitting up big contiguous songs into multiple songs, trimming songs, cutting out audio 
mistakes, and most importantly FUN!  Check out some popular uses.

Record and Convert Your LPs/Cassettes to CD 

Make A 60 Second Commercial With Music 

Make A DJ Mix CD 

Record Your Band 

Create An MP3 For "Pod-Casting" Or Internet Distribution 

Create A Ring Tone For Your Cell Phone 

Remove Vocals From A Song 

MIXCRAFT™ FEATURES

� Easy to use multitrack audio mixing!

� Unlimited tracks depending on your computer’s processing power!

� Pan, volume, solo and mute on each track.

� Time stretch sounds and songs without ‘chipmunking’ them!

� Cutting edge 32 bit sound engine for maximum sonic quality!

� Convert your LPs & cassettes to CD



� Produce your first hit record and burn a CD right in Mixcraft.

� Read and write high quality audio, including broadcast quality 24 & 32 bit WAV files up to 192 
kHz.

� Import compressed MP3, OGG, WMA and WAV files!

� 6 Powerful Effects including

o Reverb – Simulate environments 

o Delay – Create multiple echo effects 

o EQ – Boost bass, treble, mid-range, 10 band EQ 

o Compression – Boost dynamics to sound louder 

o Flanger – Create a whooshing effect 

o Chorus – Double up your vocals

o Distortion – Give it some grunge!

� Support for 3rd party VST & DirectX effects!

� Shape your sounds with resonant filter automation.  Great for DJs!

� Easy looping tools – Create loops out of sections of other sounds or songs.

� Render to Realaudio, MP3, OGG, WMA and WAV, including broadcast WAV files at high 
sample rates and bit depths.  (Includes 24 and 32 bit sounds and sample rates up to 192kHz) 

Copyrights & Trademarks

Acoustica Mixcraft © 2005 Acoustica. All Rights Reserved.

Includes Xaudio software Copyright © 1996-2005 Xaudio Corporation.  All Rights Reserved. 

Microsoft Windows Media Format (c) 2005 Microsoft Corporation. All rights reserved.

Thanks to Stephan M. Bernsee for time stretching routines!  http://www.dspdimension.com 

Many thanks to the LAME team for their work on the LAME encoder.  See their website at mp3dev.org/mp3/

MPEG patent technology licensed by Thomson @  www.mp3licensing.com 

OGG support © 2005, Xiph.Org Foundation

� Redistributions of source code must retain the above copyright notice, this list of conditions and the following 
disclaimer. 

� Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials provided with the distribution. 

� Neither the name of the Xiph.org Foundation nor the names of its contributors may be used to endorse or promote 
products derived from this software without specific prior written permission. 

This software is provided by the copyright holders and contributors "as is" and any express or implied warranties, including, but 
not limited to, the implied warranties of merchantability and fitness for a particular purpose are disclaimed. In no event shall the 
foundation or contributors be liable for any direct, indirect, incidental, special, exemplary, or consequential damages (including, 
but not limited to, procurement of substitute goods or services; loss of use, data, or profits; or business interruption) however 
caused and on any theory of liability, whether in contract, strict liability, or tort (including negligence or otherwise) arising in any 
way out of the use of this software, even if advised of the possibility of such damage.



Quick Start
So you’re in a hurry, eh?  Let’s follow our favorite musician "Sound Warrior" (SW) through the paces of 
using Mixcraft ™.   

Load in sounds

SW starts Mixcraft and clicks "Add Sound" from the "Mix" menu.  He finds a groovy beat called ‘
funky-groove-120-bpm.wav’ and clicks "OK". 

Position sounds

SW clicks on the new sound and moves it to track 1 so that it starts at the beginning of the track.

Create loop

To add looping, SW moves his mouse to the right side of the sound until the cursor looks like a <-> .  
SW clicks and drags right to loop the sound.  Each loop is represented by a tick so that he can visibly 
measure out 10 loops.

Change filter over time

SW wants the loop to grow in intensity over time and instead of just changing the volume over time, he 
decides he wants to change the frequency over time!  SW clicks on the "Show Env" control on the 
toolbar and switches it to "Low Pass Cutoff"  He moves the mouse to the first envelope point and drags 
it down to the bottom of the sound.  Then he switches the "Show Env" control to "Low Pass Resonance" 
and adjusts the first envelope point to the top.  He proudly listens to the piece of art by clicking the Play 
button on the toolbar.  "Not bad!" he thinks.

Add more sounds

He adds a bass part and a synth pad on tracks 2 & 3.  He then records some vocals on track 4 that go 
like this "yo baby, you know I luv ya…" you get the idea. ;-)  Something is missing though… 

Add Effects

He decides to add some echo or delay to his vocals so that "yo baby" sounds more like "yo yo baby 
baby".  He clicks on the "FX" button on track 4 and selects "Delay" from the list.  In a sudden inspiration, 
he decides that the whole thing needs reverb and clicks "Main FX" on the master control panel to add 
global reverb.  Now it sounds just right!

Mix it down to MP3

Soundwarrior needs to mix it down to a single sound.  He chooses "Mix Down To" followed by clicking 
"MP3".  He selects a filename and clicks save.  Without hesitating he launches his email browser and 
starts composing a new message to his current #1 fan.  "Dear Mom, you’ve gotta check out this new 
piece I made!!!"

Burn it to CD

Soundwarrior is so happy with himself he decides to burn a spinning wheel (also known as a CD) so 
that he can play it at the next ‘rock’ concert.  He adds a few track markers, and clicks burn.  Minutes 



Registration / Purchasing Options
Mixcraft has a trial period of 7 days without any restrictions!  After that, you will need to purchase a 
registration code to continue using the software.

We have put many hours into this software and we hope that you decide to purchase the software!

Benefits of Registration

o Unlimited and unrestricted usage: mix to your heart’s content! 

o Support Acoustica and future products of the same caliber.

You can purchase a registration code right now and automatically receive a registration code in 
your email within minutes.  

BUY NOW! 

To purchase a registration code, click the "Buy Now On-line" item from the "Help" menu or the "BUY" 
button on the toolbar.

If you don’t have the software up now, visit the website to purchase a code.  Go to 
www.acoustica.com/mixcraft/buy.asp 

Purchase methods

o Credit card 

o Pay Pal – pay via the popular service Pay Pal

o Snail mail or postal mail – send in a mail with a money order or check. 

o Phone Order - Make a call to send payment.

The price of registration is not much more than the cost of a large pizza!  The price may actually vary 
which is why it isn’t listed here.  (More instructions are on the website.)

Once you purchase the software, you should receive instructions on completing the registration and 
entering in your registration code.  However, if you do not hear back within 1 day, please visit the 
following support site.  Lost Codes Department 



Version History
To check for a new version, select "Check For Update" from the "Help" menu or you can visit the 
website at www.acoustica.com 

Version 2.01 – May 2005

� Added time stretch without ‘chipmunkizing’ sound!

� Added pitch change without altering length of sound!

� Added ability to set ISRC field for mastering CDs.

� Fixed recording bugs

Version 2.0 – May 2005

� Enhanced recording dialog

� Added mixer selection controls on recording dialog

� Auto timer for recording

� Burn audio CDs – can burn selections as well. (Via Goldenhawk or IMAPI)

� Enhanced track markers, including a new track marker wizard, which makes it really easy to 
split a recorded LP or cassette sound into multiple tracks.

� Added new easy envelope modifiers to boost, cut, fade in and fade out the various envelope 
parameters.

� VST Effects supported

� DirectX Effects supported

� Interface improvements – Better keyboard control and faster drawing of sounds, improved 
splitting, improved zooming.

� Integrated with Acoustica CD Label Maker.  (Requires a separate purchase)

Version 1.1 build 18 – Feb, 2005

This is mainly a bug update/fix.

� New demo song

� Fix for saving freeze 

� Fix for marker drift 

� Fix for tooltip slow down for mp3s 

� A few text changes, ie: copyrights ,etc. 

� Copy and paste works for track text 

� Added Beatcraft to additional Acoustica products in Help menu. 

� Better WMA support 

� Added Distortion effect 

� Effects now are graphically 'Acoustica effects' 

� Fix for not rendering effect tails in certain cases. 

� Tooltips now working again over sound clips. 

� MP3 tag info now saved properly in MP3s. 

� Changing length of clip via "Sound Properties" now adjusts master internal length properly. 



� Recording dir, MXP dirs, Add Sound dir has their own last used directory so you don't have to 
keep switching dirs all the time. 

� Can now use from different users without having to reinstall for each user account!

Version 1.1 build 12 – May 29th, 2004

� Add ability to export OGG files.

� Improved caret keyboard control

� Added hot key to play from previous marker

� Added split clip feature

� Added join feature

� Reduced overdubbing latency

� Fix for playback pop for rate changed sounds

� Added Ctrl+R to bring up recording dialog

� Added ability to set exact offset and length via ‘sound properties’ 

� Keyboard focus bug fixes

� Fix for panning bug – was not restoring pan control properly when loading a project.

� Fixed crash related to undoing and deleting sounds.

� Added support for 24 bit playback and recording.  (Requires a soundcard that supports it)

� Other bug fixes

Version 1.0 build 11 – May 13th, 2004

� Adds ability to import OGG files.

� Bug fix with pan control when loading old projects

� Bug fix with ADPCM WAV files not rendering properly

� New Save As dialog that allows you to type in a name for the freshly recorded sound.

� Bug fix for recording on Win98/95/ME machines that would crash after 12 minutes of recording

� Zooming fix

� Other bug fixes

Version 1.0  - April 2004

� Initial Release!



Acoustica was founded in 1998 and is located in the foothills of the Yosemite Valley.  Acoustica's 
mission is to create high quality, intuitive and powerful software.  We value diligence, creativity and 
innovation.  We are embracing Internet technology and the new world that it is creating.  We also have 
this curious idea that SOFTWARE SHOULD BE EASY TO USE! ☺

Mixcraft is the latest in a series of highly innovational and user-friendly software we are making.  Our 
other products include MP3 To Wave Converter PLUS, MP3 Audio Mixer, MP3 CD Burner and CD/DVD 
Label Maker, Audio Converter Pro, Photos Forever & Beatcraft.

Acoustica
P.O. Box 728

Oakhurst, CA 93644

U.S.A.

www.acoustica.com 

Copyright © 1998-2005 Acoustica.  All rights reserved.  No part of this manual may be copied, 
reproduced, translated or transmitted in any form by any means for any purpose without the express 
written permission of Acoustica.



How To?
Maybe you aren’t quite sure on how to do one of the following tasks…Mixcraft is quite flexible!

Record and Convert Your LPs/Cassettes to CD 

Make A 60 Second Commercial With Music 

Make A DJ Mix CD 

Record Your Band 

Create An MP3 For "Pod-Casting" Or Internet Distribution 

Create A Ring Tone For Your Cell Phone 

Remove Vocals From A Song 

Try the animated tutorials on the Acoustica website! 



Record Your LPs & Cassettes to CD
So you’ve finally decided to transfer your LPs and Cassettes to CD?  For this project, you’ll need the 
following:

� Record/cassette player with headphones or RCA output.

� Cables (May not need all depending on setup)

o Cable A: Stereo RCA to 1/8" stereo mini cable.

o Cable  B: ¼" Stereo ‘Phone’ headphone jack to a 1/8" stereo mini cable.

o Cable C: RCA to RCA

� A soundcard

� Mixcraft 2.0! ☺  

Getting the right input level is the tricky part.  

LP/Record Players

Record players are special and have extremely low output levels.  If you have a Headphone jack, this 
is your easiest option.  

A) For record players with built in headphone jacks, simply connect a cable type B from the 
headphone jack directly into soundcard’s "Line In".  

B) If you have a ‘Line Out" option on the back of your record player, you can connect cable type A 
from your record player to the "Line In" on your sound card.  

C) If you have "Phono Out" on your record player, you’ll need to connect your record player to an 
amplifier’s "Phono In" with cable type C.  This is important because the "Phono" level signal is very low 
and is different than other CD and tape signal levels.  If you have an amplifier, you’ll need to connect 
the "Line Out" from the amplifier to the "Line In" of the soundcard using cable type A or if the amplifier 
has a Headphone jack, you can connect a cable type B from the headphone jack to the soundcard’s 
"Line In"



Cassette/Tape Players

Cassettes/Tape players will have either a Headphone option or a "Line Out" on the back.  You can use 
cable type B to go from the headphone jack into the "Line In" of your soundcard or you can use cable 
type A to go from the "Line Out" into the "Line In" of your soundcard.

Getting The Cables
You can purchase cables online or at electronic part stores such as Radio Shack.  If your computer is 
far from your record player you may be able to purchase extension cables, as well.

Getting The Right Level

Now that you’ve got your cables set up, you need to get the right level.  You’ll be adjusting your 
soundcard’s input level and the output of the record player or cassette deck to get the best settings.

Launch Mixcraft and click the Record button on the toolbar. 

Select the correct soundcard from the soundcard drop down and then in the source control select 
"Line In".  It may also be called "Analog Mix" and if you’re not sure and have an option called "What U 
Hear", use that.

Start playing the record or tape.  Start at the loudest part of the song.  Make sure that you are seeing 
yellow but not red.  If you are seeing red it means that it is clipping or distorting.  

Try turning down the volume of the cassette deck or record player if it is red.   You may also adjust the 
slider up or down which controls the input level.

You also want to avoid having a really flat signal.  If the signal stays at the same spot and does not 
fluctuate very much, try turning down the volume on the cassette or record player and moving the input 
slider more to the right towards ‘Max’

Setting The ‘Auto Stop’ Timer

Sitting there waiting for the recording to end is tedious.   That’s why we created an ‘Auto Stop’ timer!  
If you are recording a 30minute LP, set the timer to 30 minutes.  (It will play a sound when its done to 
let you know its finished.)

Ready To Record

Uncheck the "Overdub" option.  Also, make sure that you have the correct sample rate set.  The 
software defaults to CD quality (44,100 Hz, 16 bit, stereo), but for those hi-fi people out there, you can 
record at 24 bits and up to a 192 kHz sampling rate.  (Click "Change…" to launch the preferences so 
that you can change the recording format, if desired.)

Click the Record button.  Now start your record player or press play on your cassette deck!!

(Feel free to take a break while it records.  Get a coffee, do some dishes, etc..)



Recording Is Done

After the sound chimes, your recording is done.  You should see a sound bar representing the sound.  
Listen to it and make sure that it isn’t distorted.  If it is distorted sounding go back to "Getting The 
Right Level".

Splitting Your Recording Into Tracks

First, make sure that your sound is at time offset 0.  Then click "Automatic Marker Wizard" from the 
"Marker" menu.  Click "Based On Silence In Sound" and then click "OK".  You should now have 
multiple tracks with track markers.  If the wizard didn’t automatically split them into separate tracks, 
click "Undo" from the "Edit" menu and try the "Automatic Marker Wizard" again with different 
parameters.  Alternatively, you can manually split the tracks by clicking on the sound pressing Ctrl+T 
or "Split" from the "Sound’ menu.

Naming The Track Markers
If you are going to be saving your recording as multiple MP3 files, you will probably want to name the 
tracks.  Right click on the first track marker and select "Edit Marker…"  Type in a name and then click 
"Next" to go to the next track marker.  If you aren’t sure what song it is, click the "Play" button.

Record Side B

Since CDs can hold 74 minutes of audio, you can easily put a whole LP or cassette on one CD.  
Repeat the recording process and record the second side.  After its done recording, position the clip 
and run the marker wizard again.  (Make sure to select the new recording as the sound to run the 
wizard against.)

Burn A CD

Save the session and then click "Burn CD" from the "Mix" menu.  Put a CDR in your CD recorder and 
then click "Start".  Your CD will pop out of your CD recorder ready to be played in any CD player!  You 
may want to check out our optional CD Label Maker to make a gorgeous CD Label for it.

Create MP3s 

You can also choose to mix these songs down to MP3 files.  (One for each track!)  Just select "Mix 
Down To " from the "File" menu followed by selecting "MP3".  Choose a folder and base name such as 
the ‘Artist-Album’.  Select a desired quality and click "Save".



Make A 60 Second Commercial With Music
Audio can be used to brand your product or service.  If you need to make your own radio commercial or 
Internet audio ad, Mixcraft makes this easy!

Create Your Script

Type and edit your script using any word processor.   Print it out and go over it a few times to make sure 
that it is about 60 seconds in length.

Record Your Script

Record yourself reading the script.  If you make mistakes, don’t worry; you can redo parts of it later.  
Click the "REC" button on the toolbar and click "Record" to start recording.  Click the caret to position 
where the recording will start.

Add Some Music

You can purchase royalty free music from sites like PartnersInRhyme  or search in your favorite search 
engine for ‘royalty free music’.  In addition, if there is a song you’d like, you can rip it from a CD using 
Audio Converter Pro or download it from a service such as Emusic, as long as you secure the rights 
from the song’s copyright owner or through an agency such as the Harry Fox agency.  Of course, if you 
have musical chops, record your own song or just grab a free loop.

Edit The Music

If you have added a song, you’ll need to edit it so that it fits in 60 seconds.  If you like the chorus, make 
sure to crop it from the left and right so that the only part left is the chorus.  Alternatively, if you want to 
loop a sound, click on the right side of the sound and drag to the right to loop the sound. 

Reduce Volume At Key Points

You can add volume points manually, or you can select the area on the music that is clashing with the 
voice part and lower it by clicking "Reduce 20%" from the "Sounds" menu.  If it’s not low enough, hover 
your mouse over the volume line until it turns into an up/down arrow.  Drag it to the best level.

Add Some Sound Effects

Need a bit of applause or a cartoon sounds?  You can download some or purchase royalty free sounds 
from the Internet.  Or you can record your own, of course!  Add and position the sounds, as you’d like.

Finish With Effects
You may want to put some Compressor on the voice track to give it that extra boost, or you can use 
delay/echo to accent a specific part of the voice track.  To delay a part, cut the part out and paste it to 
another track with delay/echo.  Add some global reverb to give it a sense of space.

Create An MP3 or Burn A CD

Save your mix by selecting "Save" from the "File" menu.  If you wish to make an MP3, select "Mix Down 
To ", followed by "MP3".  Type in a name, click OK and then select a format.  Click "Save" to finish the 
process.  To burn an audio CD, click the CD icon on the toolbar or select "Burn CD…" from the "Mix" 
menu.



Make A DJ Mix CD
In order to create a great DJ Mix CD, you should learn a few of these tricks.

Automatic Play List Import

If you have a play list, you can automatically import and mix all the contained songs. (Play list types 
include: m3u, pls, pl, cbs, asx, cl3, cl4, cl5, nra, pya, rcl, rmp, rxp, wax, wpl, wvx, xml, txt.)  This will 
overlap all songs in the play list and place a track marker at each intersection.  This is a good for a 
basic mix, but there is no guarantee that it will actually sound good!  To import a play list, select "Import 
Play List…" from the "File" menu.

Automatic Fading By Overlapping Songs

You can drag a song over another song and make an automatic fade!  Use the keyboard shortcuts to 
move the song to the best sounding offset.  The hashed area shows the overlapping area.

Get The Beats Lined Up

Crop the songs so that they start at the right spot.  Use the envelopes to create fade ins and fade outs 
during the transitions.  You might even change the pitch of one song slightly so that the beats line up 
better.  To change the pitch/rate of a song, right click on the song and select "Change Pitch…"

Create a Lo-Fi Intro

Ever hear one of the songs that starts out sounding like it’s on a cheap radio speaker and then as it hits 
a bridge it bursts into full glory?  You can do this by splitting a sound and placing the first part on a track 
with LoFI EQ.  To do this, click the mouse at the offset you’d like to split the sound.  Press Ctrl+T or 
select "Split" from the "Sound" menu.  Now click the first part to select it and use the keyboard down 
arrow to move it down the next track.  Click the "FX" button and select "Acoustica EQ" from the drop 
down.  Select "Lo Fi" from the Preset drop down to finish this trick.

Create A Resonant Filter Fade In

This is a really nice trick that gives a fresh energy to a song.  The listener hears a low beat and, slowly 
over time, hears new parts coming out of the mix, as it gets brighter and brighter.  Select the "Low 
Resonance" from the Show Env: control on the toolbar.  Move your mouse over the envelope line until it 
turns into an up/down arrow and drag it up half way.  Switch the Show Env: control to "Low Cutoff" and 
select the first 30 seconds of the song.   Select "Fade In" from the "Sound" menu to create a fade with 
the Low Cutoff.   You can also add your own envelope points, adjust the resonance level, change the 
resonance level over time.  You can do the opposite effect by using the "High Cutoff" and "High 
Resonance" for fade-outs or interesting transitions.

Create A Flangy / Panning Transition

Select an area of the song that is a good for a transition or, perhaps, create a loop with Beatcraft at the 
right tempo.  Cut the section out of the song and put it on a new track.  Add some Flange and pan the 
section of the sound from the one side to the other for an interesting effect.  Add a Delay effect to really 
mix it up.



Position Your Track Markers

If you are burning a CD with multiple tracks, you’ll need to add some track markers.  Select "Add 
Marker..." from the "Marker" menu or double click on the time line.  You can also right click on the time 
line.  Preview the marker positions by clicking "Play".  If you are using CD-Text or creating MP3s, name 
each track so that they will be properly tagged.

Burn A CD Or Mix Down To Compressed Audio Files

If you are making a CD, click "Burn CD".  If the software does not find a supported CD recorder, you 
can also export the tracks as multiple WAV files @ 44,100 Hz, 16 bit stereo and use another program to 
burn them.  If you are creating multiple compressed files, select "Mix Down To" from the "File" menu 
and then select MP3, OGG, WMA or RealAudio.



How To Record Your Band
There are two ways to record your band using Mixcraft.  The first method is the ‘live’ approach, in 
which the entire band plays the song through in one take and in recorded ‘live’ by Mixcraft.  The 
second method is the ‘multitrack’ approach, in which each instrument or vocal track is recorded 
separately in isolation, then all are mixed together to create a perfectly blended recording.  The ‘live’ 
method is a great, fast way to create demo-style tracks of your songs.  The ‘multitrack’ method is the 
method typically preferred by recording studios, and it offers the most flexibility and control over the 
final mix.

To record your band in a ‘live’ or ‘multitrack’ fashion, you will need a hardware audio mixer.  Audio 
mixers come in many sizes and range from inexpensive to very expensive.  

The most important consideration for you when purchasing a hardware audio mixer will be to 
determine the number of channels you need.  If your band is very simple – such as one guitar and two 
singers – you may only need 4 channels available on your mixer:  two microphones for the vocals, one 
or two microphones for the guitar.  If your band is larger, you may need a much larger mixer, to 
accommodate microphones for drums and guitar cabinets, acoustic instruments, keyboards, and 
vocals.

When all instruments are mixed through the mixer, you can connect your mixer to your sound card.  
Many consumer-style mixers have RCA outputs, and most professional mixers have ¼" outputs.  

Depending on the output of your mixer, you may need:

� 2 ¼" mono outs to 1 1/8" stereo mini

� 1 RCA jack to 1 1/8" stereo mini

� 2 or more ¼" mono plug to 1/8" mini or ¼" mono plugs.  (If you have a soundcard that 
supports multiple inputs.)

� Another combination of the above.

‘Live’ recording

For live recording, you will want to route every instrument into the mixer on its own dedicated channel.  
You will then want to set the levels for each instrument.  Use headphones or loud speakers to achieve 
a mix you are happy with.  Mixcraft will record the output of the mixer, so if the mix is not quite right, 
you will not be pleased with the recording.  Pay special attention to achieving a full mix that sounds 
good to you.



Once your mixer output is wired to your sound card input, launch Mixcraft, and begin recording.  Have 
your band play through the entire song.  It is often best to play through the song multiple times and 
select the recording that sounds best.  If you are not pleased with the sound of the mix, make your 
adjustments on your mixer and record the song again.  

When you have a recording that you are happy with, trim the noise before and after the song.  You can 
now save this recording to a .WAV or .MP3 file, or burn it straight to a CD!

‘Multitrack’ recording

In this approach, you will record each instrument individually, in isolation.  You will still want to 
purchase a mixer to allow you to plug in different sorts of microphones and instruments, and to control 
and EQ the sound before its recorded.  If you have a large band, it is often desirable to record your 
tracks in the following order:

1) Drums

2) Bass

3) Guitar/Keyboard

4) Lead vocals

5) Harmony Vocals

Since drums are typically the foundation for a song, it is very desirable to begin with a drum recording.  
It can be very difficult to record drums later, along with a guitar or keyboard part, as the timing will 
usually be off in subtle ways.

Use one or more microphones on the drum set, and run them through the mixer.  Mix these channels 
to create a stereo drum mix that you are pleased with.  Then use Mixcraft to record the complete drum 
part.  Alternatively, you can use Beatcraft to create synthesize a drum track.

Next, use the ‘Overdub’ recording feature of Mixcraft to record more parts onto individual tracks, and 
use Mixcraft’s track controls to adjust the volume and panning of each track:

Finally, consider using effects in a subtle manner to change the sound of the recording.  Using a 
room-style reverb effect on the drum recording will make the drums sound fuller, and place them in a 
space.  Using EQ on an acoustic or electric guitar recording can help emphasize the high and low 



frequencies of the guitar while cutting back on the midrange frequencies, which can muddy up a 
recording.  Flangers and phasers can create amazing effects on guitars and keyboards.  Likewise, 
delay, EQ, and reverb can all sound great on vocals!  Remember that effects are like spices, and 
should be used lightly – a little goes a long way!

Once all of your tracks are recorded, mixed, and processed, use the Render feature to save the entire 
recording as a WAV, or render to an MP3 or other compressed format and email the song to your 
friends or place it on your web site!  

You can also use Mixcraft to record your song to a CD.  The best recording engineers will play the CD in 
their car, on their home stereo, and anywhere else they can play it to make sure the mix sounds good in 
all these locations.  Sometimes a mix that sounds very good on your computer speakers can have too 
much bass in your car or on your home stereo.  Experimenting with mixing can be very rewarding!



Create An MP3 For "Pod-Casting" Or Internet 
Distribution

Get the word out!  Blogs are the rage these days and "Pod-Casting" is the latest trend in audio 
publishing.  It all boils down to the same thing, though: creating and uploading an MP3 file.

Create Your Audio

Perhaps you are commentating on your day, or perhaps, you are doing a critique on the latest hip hop 
album, or maybe you are producing a news report for your college radio station; When you are done, you
’ll need to save it to an MP3.  Keep in mind that if you are creating a small file, many listeners will not 
hear the subtle higher frequencies, depending on the type of compression being used.

Pick A Final Format

Most people will choose MP3, but you can also mix down to OGG, WMA or Realaudio.  Select "Mix 
Down To" from the "File" menu and then select a format.  Pick a setting, type in any tag information and 
then click "Save".  Keep in mind that higher quality sounds are also larger in size and will take longer for 
your listeners to download/stream.  If your target is for all users, then you will need to pick a highly 
compressed format so that it streams easily.



Create A Ring Tone For Your Cell Phone
One of the hotter trends with cell phones is making custom ring tones.  Many newer cell phones support 
the ability to play audio and recordings.  If you have one of these types of cell phones, it should be able 
play MP3s.

Creating Your Own Ring

It should be relatively short.  Most people answer their phone within 20 seconds or it goes to voice mail 
in at least 20 seconds.  Choose a song and use the loop editor to narrow down a riff and make it loop.  
Overlay your voice, add some sound effects and then mix it down to MP3.  Select "Mix Down To" from 
the "File" menu and then select MP3.  Pick a folder and file name and click "Save".  Pick a format, such 
as 128 kbps and then click "Save" again.

Renaming Your .MP3 To .MID

We’ve tested this with a Verizon LG phone and found that you have to rename your MP3 file to a .MID 
file.  Locate the folder where you saved the MP3 and select it.  Right click on the file and select 
"Rename".  Type in a new name and end it with ".MID".  (Note that if you did not see the .MP3 in the first 
place, you’ll need to show extensions by going into "Folder options" on the "Tool" menu of the folder.  
Click "View" and make sure that "Hide extensions for known types" is unchecked.)

Getting Your Ring On Your Phone

The easiest way to get your ring on to your phone is to email it to your phone as an attachment.  For the 
Verizon phone we tested, the email address is the area code followed by the phone number @ 
vzwpix.com .  For example, if your cell phone number was 555-111-2222 then the email would be 
5551112222@vzwpix.com .  Of course, this is the way it works currently for Verizon picture phones, and 
it may not necessarily work in this exact way for your phone. Create an email and attach the .MID file 
created in the previous step.  Send it and in a few moments, you will receive a message.  On your cell 
phone, save the sound and then go into the options or the menu to set it as your main ring.  Consult 
your manual or the Internet for more help on your particular phone.

(You may also be able to hook up your phone via USB to transfer it.  In addition, there are specific 
dedicated programs to transfer your audio files to your cell phone.)



Removal Vocals From A Song
Vocal Removal is a very inexact science, and it is very difficult to completely remove vocals from a 
song.  However, with many songs, and the latest technology, it is possible to do a very thorough job 
when it comes to removing vocals from a recording.

Download a vocal removal plug-in

The Extra Boy vocal removal VST plug-in, created by Elevayta (www.elevayta.com), is a free, 
high-quality vocal removal tool.  Download the Extra Boy vocal removal plug-in from Acoustica’s site at 
the following URL:

http://www.acoustica.com/plugins/vst-directx.htm 

Install this VST Effect, and restart Mixcraft.

Load a song

Load a song and place it at time zero on track one:

Next, press the FX button on Track 1, and you will see the Track 1 Effects dialog:



Click on the ‘Select New Effect To Add’ drop-down and load the Extra_Boy effect:



Select the ‘Full Spectrum (HR)’ preset.  The (HR) presets are High Resolution presets and will give 
you better results.

Play!

Now, press Play in Mixcraft and you will hear your song with reduced vocals.  This process is not 
always perfect, and depends on the song, but sometimes the results can be very, very good.  

You can now Render the results to a WAV file, MP3 file, or other file format using the File Render 



function, or you can burn the track directly to CD.  In addition, you can string a number of songs 
together on the same track, one after the next, and use the CD Track Marker and CD Burning tools to 
burn a music-only CD.  This is great for karaoke parties!

Experiment!

Experiment with the controls in Extra Boy.  Try different settings and see if you can achieve better 
results.  There are additional presets as well which may give you better (or worse!) results.  Since 
Vocal Removal is a very difficult science, it is difficult to make a preset that works on all sorts of sonic 
material, so tweaking the controls can greatly improve your results.  Have fun with it!



How To?
Maybe you aren’t quite sure on how to do one of the following tasks…Mixcraft is quite flexible!

Record and Convert Your LPs/Cassettes to CD 

Make A 60 Second Commercial With Music 

Make A DJ Mix CD 

Record Your Band 

Create An MP3 For "Pod-Casting" Or Internet Distribution 

Create A Ring Tone For Your Cell Phone 

Remove Vocals From A Song 

Try the animated tutorials on the Acoustica website! 



Main Window

Tracks

Tracks are what hold the sounds.  Each track can have its own Effects, volume and pan adjustments.  
These settings only affect the sounds on the track.  More on Tracks

The above image shows the track header, the track and a sound on the track.

Master Control

This is the global or master panel, which affects the entire mix.  After all the tracks have been 
processed, the sound signal is sent through the Master Control where volume and master effects are 
applied.  For example, it will give you much better performance to use an overall reverb on the Master 
Control versus applying the same reverb on every track. 

The Caret

The caret represents the location where new sounds will be placed.  It is also where new recordings will 
be placed.  Before recording or adding sounds, make sure to move your caret to the desired location.  
Zooming in and out uses the caret as the zoom point. Position the caret before zooming in or out.  (A 
nice trick when zooming in and out is to spin the middle mouse wheel.)

Timeline

The timeline is above the track area and helps you to line up sounds at specific times.  You can also 
add markers to the timeline, which can help with lining up  More on the timeline. 

Menus & Toolbar

The toolbar contains many of the common functions, including zooming and envelope selection.  
Explore the menus for new features.  Menus - Toolbar 

Status Bar

This displays information about the selected sound(s) or the mix, depending on what is active.



Master Control

Peak & Clip Meter

The peak meter is a graphic way of showing how loud the mix is.  The red clipping meters will light up 
and stay lit for 5 seconds if the volume is too loud.  Generally, you should avoid clipping and it is 
recommended to lower either the master volume or another volume.  The above image shows clipping 
in both the left and right channel.  Tip:  Solo a track to see if it is clipping.

Master Volume

This is the master volume for the entire mix.  If your mix is too loud, lower the master volume to avoid 
clipping.  You can use the slider or type in a new value.  The range is 0% to 200%.

Main FX

The main effects are applied to the entire mix after all tracks have been mixed.  Usually, one might use 
a global reverb or possibly a compressor.  To edit the effects, click the " Main FX" button.



Tracks
Tracks are audio channels that have their own volume, pan and effects.

Track Name

Give your track a name, feed it some track food and love it dearly.  (What else could I write here? ☺) 

Volume & Pan 

After all sounds on the track have been mixed, each track has its own volume and pan adjustment.  You 
can either use the slider or type in a value via an edit box.

Track Effects (FX)

Each track has its own effects that are added after all sounds have been mixed together.  In addition, 
the effects are added after the track volume and pan have been applied.  To add or view effects, click 
the "FX" button on each track.  More on Effects …

Mute

Mutes or silences all sounds on a track.  Note: All muted tracks will stay muted during a mix down. 

Solo

Solos this track so that it is the only track you hear.  This is convenient way to listen to a specific track 
without hearing the others.  Note that it is possible to solo more than one track, and, thus, you will hear 
all soloed tracks.

Add a New Track

To add a new track, click "Add Track" on the "Mix" menu or click the "Add Track" button below the 
lowest track header.  The other way to add a track is to simply drag or move a sound down.

Insert A Track

To insert a new track, right click on the track and click "Insert Track". The new track will be inserted 
before the track you right clicked on.

Move Track Up

Right click on a track and select "Move Track Up" to move it up.

Move Track Down

Right click on a track and select "Move Track Down" to move it down.



Timeline
The timeline helps you position your sounds.  Depending on your zoom level, you will see time in 
minutes:seconds or minutes:seconds:milliseconds.  If your mix is longer than an hour, you will see 
hours:minutes, etc.

Playback control

Click on the timeline during playback to start playing from the new location.

Track Markers
More information on track markers and the Track Marker Wizard. 



Track Markers
Track markers can be used to line up sounds and loops or note important events.  Each tracker marker 
can have a name.  Track markers can optionally represent a "CD Track Marker" which will cause 
Mixcraft to render out a new track when doing a multi-file mix down or start a new track when burning a 
CD.  Use track markers to:

� Create an audio soundtrack for a video, by adding a track marker for each important video 
event.

� Sync up loops and sounds.  Zoom in and line up each sound to an exact millisecond.

� Burn a mix CD in Mixcraft

� Create a mix CD from exported WAV files so that each track marker represents a new track.

Add Track Marker…

To add a track marker, either double click on the timeline or right click and select "Add Marker".  Give 
you marker a name and optionally uncheck the "CD Track Marker" if you don’t want this marker to start 
a new CD track.

Edit Marker / Edit Nearest Marker…

This brings up the edit marker window which lets you fine-tune the marker location, change its name 
and whether it’s a CD track marker or not.  Once in this dialog, you can adjust all markers by using the 
Prev and Next buttons to go to and from subsequent markers.

ISRC Codes (For advanced users)

If your intention is to burn an audio CD for commercial use, you may need to enter in your ISRC codes.  
After you’ve been issued your ISRC code, click the ISRC checkbox and type in the code for each track.

Track Marker Wizard

The track marker wizard is a handy way to add multiple track markers at a time.  You can either choose 
to add markers at specific intervals, or you can add markers based on the silence in a sound.  It will 



even remove the silence!  This can be very handy if recording albums from the Internet, LPs or 
cassettes and need a quick way to break up the tracks!

Before: We have one large sound with gaps between tracks.

After: We have 7 track markers and 7 sounds. (The silence has been removed)

All you have to do after that is to rename all the track marker names and then click "Burn CD" from the 
"Mix" menu.

Play From Marker

If you right click on a marker, you can start playback from the marker.

Play From Previous Marker

If you right click on the timeline, select this to start playback from the previous marker.  You can also 
push Ctrl+Shift+[SPACE] to do this from the keyboard!

Play From Next Marker

If you right click on the timeline, select this to start playback from the next marker.  You can also push 
Ctrl+[SPACE] to do this from the keyboard!

Delete Marker

Right click on the timeline and select "Delete Marker" to remove the marker.

Delete All Marker

Right click on the timeline and select "Delete All Marker" to remove all markers.  (Note that the first 
marker will never be removed.)



See more on mixing down to multiple WAV files. 

More on the CD Track Marker? 



Menus

File 

Edit 

Mix 

Sound 

Markers 

Help 



Keyboard Controls

Moving Sounds Around (assumes a sound is selected)

(<-  or ->  ) +/- quick move (depends on zoom level.) More.. 

Ctrl + (<-  or ->  ) +/- 20 milliseconds. More..

Ctrl + Shift + (<-  or -> ) +/- 1 millisecond. More..

Moving the Caret Around 

(<-  or ->  ) +/- quick move (depends on zoom level.)

Ctrl + (<-  or ->  ) +/- 20 milliseconds.

Ctrl + Shift + (<-  or -> ) +/- 1 millisecond.

(Up arrow or down arrow) Move the caret between tracks.

Navigating around sounds

TAB Select next sound.  More …

Shift+TAB Select previous sound. More …

[Esc] Deselect any selected sounds.

Playback controls

SPACE  bar Start or stop playback.

SPACE + Ctrl Playback from next timeline marker.

SPACE + Ctrl + Shift Playback from last timeline marker.

 (<-  or ->  ) Minor adjustments of current playback position

[Home] Rewind playback indicator to 0.

[End] Fast forward playback indicator to end of mix.

Other

[Delete] Delete any selection of sound(s).

+ Zoom in.

- Zoom out.

Ctrl+Z Undo.

Ctrl+Y Redo.

Ctrl+X Cut.

Ctrl+C Copy.

Ctrl+V Paste.

Ctrl+A Select All.

Ctrl+N New Mix.

Ctrl+O Open Mixcraft Project…



Ctrl+S Save.

Ctrl+R Launch Record Dialog

Ctrl+J Join Selected Sounds

Ctrl+T Split Sound at Caret

Ctrl+I Trim Silence From selected sound

Nudging Sounds via the Keyboard

You can move sounds via the keyboard. Use the arrow keys to move selected sounds!

Moving horizontally along the timeline.

Use the arrows to move the sound quickly.  

Hold down the Ctrl key and the sounds will move in increments of 20 milliseconds. Hold down the 
Ctrl+Shift key to move in increments of 1 millisecond.

(<-  or ->  ) +/- quick move (depends on zoom level.)

Ctrl + (<-  or ->  ) +/- 20 milliseconds

Ctrl + Shift + (<-  or -> ) +/- 1 millisecond

Moving sounds vertically

You can move the sound vertically as well.  You may do this if you are trying to move sound(s) to 
another track.

Tabbing between Sounds via the Keyboard

If you are interested in getting around quickly in the session and love the keyboard movement features, 
you will be happy to know that you can switch from sound to sound via the Tab key and Shift-Tab key 
combination. 

The Tab key will select the next sound on the current track or the first sound on the subsequent track.  
(If you are at the end of the last track, it will go to the start of the first track.)

Holding down Shift key and pressing the Tab key will do the opposite of Tab.  It will select the previous 
sound on the track.  If it is the first track, it will select the last sound on the previous track.



Sound Basics
Each sound or clip can be edited in a variety of ways.  

(Here is what a sound clip looks like in Mixcraft.)

This sound is called "Drum Loop".  You can play it individually by clicking the play arrow.  The sound clip 
has a title bar, wave form, envelope, and a selection area on the bottom.  Each sound can be cropped, 
faded, edited in a few simple clicks and drags.  Cut, copy and paste is also extremely easy.

Adding Sounds

To add a sound, position the caret and click the "Add Sound" button on the toolbar.  Alternatively, 
double clicking on an empty area on the track will allow you to choose a sound.  Locate the sound and 
click "Open".  Alternatively, you can drag in multiple sounds directly from a Window’s folder.  Mixcraft 
currently imports WAV, MP3, OGG and WMA files.

Selecting Sounds

To select a sound, click its title bar.  Alternatively, you can select a portion of the sound by clicking on 
the bottom selection part of the sound and dragging left or right.  To select multiple sounds, click down 
in the window and drag over the sounds or portions of sounds you’d like to select.

Moving Sounds

Simply click on the title bar of the sound clip and drag it to a new location.  You may also use the 
keyboard to move the sound.  Note that sounds can overlap and coexist at the same location if desired.

Deleting Sounds

Simply select the sound or sounds and click "Cut" from the "Edit" menu or press the "Delete" key on the 
keyboard.

Cropping Sounds 

Copy & Paste 

Crossfading Sounds 

Editing sounds with a 3rd party sound editor 

Time Stretch / Change Pitch

Envelopes 

Envelope Tricks & Shortcuts 

Trim Silence 

Looping 

Recording 

Joining Sounds 

Splitting Sounds 



Cropping Sounds
By clicking on the right or left hand side of a sound and dragging left or right you can crop the sound.  
You would do this to get rid of extra silence or other unwanted audio. 

(The figure below shows a sound being cropped on the left hand side.)

You can crop from the left or right side.  Note that all envelope points will also be cropped.



Clipboard: Copy, Cut, & Paste
Select a sound or group of sounds and cut or copy.  Cut will delete the selection and store the cut in the 
clipboard.  Choose paste to paste the selection you just cut.  Copy copies the current selection to the 
clipboard (without deleting the selection).  You can select portions of sounds, as well by clicking on the 
bottom selection area of the sound and dragging left or right.  Cut, copy and paste menu items are 
located on the "Edit" menu or by right clicking on a selection. 

(The image above shows a selection of a part of a sound.)

To select a part of a sound, simply click on the bottom ‘selection’ area and drag the mouse left or right.



Cross Fading Sounds
Drag a sound onto another sound so that they overlap.  A cross section area will be drawn on the 
overlapped area, which represents the auto cross fade.  Sound will fade from one clip to the next clip.  
This is a very powerful feature!  

(The white diagonal lines represent the fade out of the first sound and the fade in of the second sound!)

Note that if a sound is entirely within another sound, it will not auto cross fade and will simply mix.



Editing Sounds with a 3rd Party Sound Editor
If you want to apply effects or editing not possible in Mixcraft, you can work with an external sound 
editor.  Make sure that you have already setup an external sound editor in the Preference dialog.  

Right click on the sound you want to edit and select "Edit in External Editor".  This brings up a dialog 
with two main choices.

o Edit a copy of the sound.
This option is the preferred method of editing a sound because if you later decide you don’t like 
it, you will be able to undo the edit.  In addition, you can have Mixcraft automatically pick a 
name for the new sound, thereby saving you the trouble.  This will happen if the "Automatically 
choose a new name for the sound" checkbox is checked.  You can also simply type in a new 
filename or browse to find one.

o Edit the original sound.  
This makes permanent non-undoable changes.  You might choose this if the sound is 
extremely large and you can’t afford the disk space to make a copy.  The con to this option is 
that it is not reversible!

Once you have picked an edit option, click the Edit button and it will launch the external editor with the 
sound.  Another dialog box appears which waits for you to finish your editing.  Make all the changes you 
want in the external editor, and save the file (in the external editor).  Go back to Mixcraft and hit either 
Done or Cancel, depending on how the edit went.  In the case of editing the original sound, it won’t 
make a difference.  However, if you edited a copy of the sound, Cancel will delete the copy from your 
hard drive.



Time Stretch / Change Pitch
Time stretching gives you control over the length of your sound or sounds.  For example, if you have 
recorded an advertisement that is 1 minute and 4 seconds but it needs to be 60 seconds, simply enter 
the value 60 seconds and click OK.  Normally, this could cause the sound to sound like a warped out 
dream or a chipmunk, but if you click the "Preserve Pitch" option it will preserve the pitch!  This will take 
a lot more CPU and slow your computer down, but the effect is stunning and real time!  (Note that 
depending on your computer speed, you may only be able to time stretch a few sounds simultaneously.)

Time Stretch

� By Sound Length – Enter in a new sound length and click Preview to hear how it sounds in real 
time.  Click "Restore" to get it back to the original length.

� By Percent Of Original – Enter in a new rate.  100% would be the default normal speed.  50% is 
two times faster and two times smaller. 200% is two times longer and two times slower.

� Preserve Pitch – Click this to preserve the pitch. Note that this takes a lot of CPU power.  (If this 
is not checked, the pitch will change as you change the length of the sound.) 

� Click "Preview" to hear a preview of the sound at the new pitch.

To change time stretch a sound, select a sound and click "Time Stretch…" from the "Sound" menu. 

Slow it down to 25% or speed it up to 4 times the normal speed!

Pitch Shift

You can also change the pitch of a sound.  Select a sound and then select "Pitch Shift…" from the 



"Sound" menu. 

� You can change a sound’s pitch by –24 to +12 semi-tones.  (12 semi-tones = 1 octave)

� You can change a sound’s pitch by partial semi-tones.  For example, you can type in "–1.43" 
semi-tones to shift the sound’s pitch down by –1.43 semi-tones.

� Click "Preview" to hear a preview of the sound at the new pitch.

� Click "Restore" to set the sound back to normal.

Thanks to Stephan M. Bernsee for the new time stretching routines!  http://www.dspdimension.com



Trim Silence

Mixcraft allows you to quickly trim the silence from the start and end of a sound.  This can be done 
manually, but it is a very handy shortcut.  Simply select a sound and select "Trim Silence" from the 
Sound menu.  Additionally, you may also press Ctrl+I to remove the silence.  



Looping Sounds
Working with loops in Mixcraft is easy.  

Creating a looped sound

Select a sound and move your mouse to the right edge.  The mouse should turn into a <-> cursor.  Click 
and drag to the right.  As you drag the mouse to the right, it creates loops.  Each loop is represented 
with a ‘v’ mark.

(The image above shows a sound looped 3 times.)

Perfecting a loop

You may have a sound that doesn’t loop well.  For example, many MP3s have extra silence and will not 
loop properly, so it is necessary to trim out the silence before looping.  Imagine we have a sound with 1 
second of silence before the loop.  Right click on a sound and click "Edit Loop".    The Edit Loop window 
pops up and allows you to fine tune the loop. The green flag and line represents the loop start and the 
red flag represents the loop end.  Click the play icon to play the loop.  Adjust the start and end of the 
loop during playback.  Click the + to zoom in and the – to zoom out.  Once you are happy with the new 
loop, click "OK".

(The Loop Editor allows you to perfect a loop.)

Tips

� Use this to remove silence from the beginning of MP3 file loops

� Grab a chorus section or loop from a popular song and create a remix.

� Create short loops to create interesting sound effects.  The minimum loop length is 100 
milliseconds or 1/10th of a second.

� WAV & OGG files will usually loop the best without having to do any editing.  MP3s and WMA 
files have problems looping unless you use the loop editor by right clicking on a sound and 
selecting "Edit" loop.



Joining Sounds
To join two or more sounds, select the sounds and then select "Join" or Ctrl+J.  This might be useful for 
quickly removing silence from adjoining clips.

For example, Soundwarrior records an hour long radio show and wants to get rid of the ads for his own 
personal use.  He loads in the show and then cuts all the ads out using the Cut or delete command.  He 
then selects the entire track by right clicking on the track header and selecting "Select All Sounds".   He 
then presses Ctrl+J or selects "Join" from the "Sound" menu.  All of his sounds are now right next to 
each other with no silence gaps and ads!!

Note that if the sounds are on separate tracks, they will not be joined.  Sounds will only be joined with 
sounds on the same track.



Splitting Sounds
To split a sound or sounds, first position the caret at the split point you’d like.  Select the sound or 
sounds and select "Split" or Ctrl+T to split the selected sound.

This can be useful when doing edits where you want one part of the sound to have an effect and the 
other to not.  The split will make sure that no audio is lost and, thus, preserves continuity.

For example, Soundwarrior has recorded "Welcome to Sound Warrior’s World" and he wants the 
"World" to echo.  He creates a second track with delay..  He then positions the caret right before the 
word "World" and selects the sound.  Then he presses Ctrl+T or chooses "Split" from the Sound menu.  
Then he selects the sound and pushes the arrow down to move the sound to the second track! 

"Not bad, not bad at all…" he thinks to himself! ☺ 

Here’s a pictorial example for those that like instant gratification.

BEFORE: (Notice the caret point is right after the word "AM")

AFTER: You now have 2 clips!



Sound Properties
By right clicking on a sound and selecting "Sound Properties…", you can view information about the 
sound, as well as set the exact offset and length.

Name

You can change the name of the sound to something more recognizable.  For example, if the sound 
was called "recording 01", you can change it to something like "chorus 5" which may make more sense!

FilePath

This shows where the file is stored. 

Format

Shows the format and bitrate of the sound

Offset

This shows the offset of the sound relative to the time line.  You can also change the offset by typing in 
a new time.

Length

This shows the length of the sound.  You can resize or loop the sound this way by entering a new length.

Size (KB)

This is the size of the file in KB



Sound Clip Envelope Basics
Each sound clip allows you to shape 6 parameters over time, so that you can, for example, fade audio 
in, and out, cut the volume in certain locations, pan from left to right speaker over time and more.  Each 
sound starts out with 2 envelope points at the start and end of the sound. You can click on an envelope 
point and move it around to the desired location.  

(The above image shows how to move an individual point.)

To add a point, move the mouse until it becomes a pencil tool, then left click and a new envelope point 
will be added.

You can move an "envelope line" by clicking on a horizontal line and dragging it up or down.

To switch the type of envelope, click the "Show Env" drop down on the toolbar.

Each sound has volume, pan, Low Pass Cutoff, Low Pass Resonance, High Pass Cutoff & High Pass 
Resonance envelopes.

Volume

Add envelope points for fades, cuts, or boosts, raising or lowering the sound’s volume.  The range is 
0% to 200%.

Pan

Add envelope points to pan the sound from left to right speaker.  The range is 100% left speaker to 
100% right speaker.



Sound Clip Envelope Basics
Each sound clip allows you to shape 6 parameters over time, so that you can, for example, fade audio 
in, and out, cut the volume in certain locations, pan from left to right speaker over time and more.  Each 
sound starts out with 2 envelope points at the start and end of the sound. You can click on an envelope 
point and move it around to the desired location.  

(The above image shows how to move an individual point.)

To add a point, move the mouse until it becomes a pencil tool, then left click and a new envelope point 
will be added.

You can move an "envelope line" by clicking on a horizontal line and dragging it up or down.

To switch the type of envelope, click the "Show Env" drop down on the toolbar.

Each sound has volume, pan, Low Pass Cutoff, Low Pass Resonance, High Pass Cutoff & High Pass 
Resonance envelopes.

Volume

Add envelope points for fades, cuts, or boosts, raising or lowering the sound’s volume.  The range is 
0% to 200%.

Pan

Add envelope points to pan the sound from left to right speaker.  The range is 100% left speaker to 
100% right speaker.



Envelope Tricks & Shortcuts
You can select a sound or a section of a sound and select one of our envelope tricks to quickly fade in, 
fade out, boost or reduce some audio.  For example, if you were making an audio advertisement that 
had a voice and some background music and you wanted the music to start out at full volume and then 
fade to a lower background level when the voice started, you could select the area of music that you 
wanted to be lower and then select "Reduce" from the right click or "Sound" menu.  This saves you the 
time of having to click and adjust with the mouse. 

These envelope tricks will work with each envelope type, ie: volume, pan, low pass cutoff, low pass 
resonance, high pass cutoff and high pass resonance.

� Fade In – This will fade in the selected portion of the sound from bottom to top.  (Remember, its 
not just for volume.)

� Fade Out – This will fade out the selected portion of the sound from top to bottom.  (Remember, 
its not just for volume.)

� Boost 20% - This will raise the envelope in the selected portion of the sound.  Use it again to 
raise it more, and then use your mouse to adjust the envelope for more fine control.  

� Reduce 20% - This will lower the envelope in the selected part of the sound.  Use it again to 
reduce it more, and then use your mouse to adjust the envelope for fine control.

TIP: Remember, this option will apply to the currently selected envelope type.  (Volume, Pan, Low Pass 
Cuttoff, Low Pass Resonance, High Pass Cutoff, High Pass Resonance.)



Envelope Tricks & Shortcuts
You can select a sound or a section of a sound and select one of our envelope tricks to quickly fade in, 
fade out, boost or reduce some audio.  For example, if you were making an audio advertisement that 
had a voice and some background music and you wanted the music to start out at full volume and then 
fade to a lower background level when the voice started, you could select the area of music that you 
wanted to be lower and then select "Reduce" from the right click or "Sound" menu.  This saves you the 
time of having to click and adjust with the mouse. 

These envelope tricks will work with each envelope type, ie: volume, pan, low pass cutoff, low pass 
resonance, high pass cutoff and high pass resonance.

� Fade In – This will fade in the selected portion of the sound from bottom to top.  (Remember, its 
not just for volume.)

� Fade Out – This will fade out the selected portion of the sound from top to bottom.  (Remember, 
its not just for volume.)

� Boost 20% - This will raise the envelope in the selected portion of the sound.  Use it again to 
raise it more, and then use your mouse to adjust the envelope for more fine control.  

� Reduce 20% - This will lower the envelope in the selected part of the sound.  Use it again to 
reduce it more, and then use your mouse to adjust the envelope for fine control.

TIP: Remember, this option will apply to the currently selected envelope type.  (Volume, Pan, Low Pass 
Cuttoff, Low Pass Resonance, High Pass Cutoff, High Pass Resonance.)



Low Pass Cutoff & Low Pass Resonance
The Low Pass Cutoff limits the high frequencies that are played.  It lets the low frequencies ‘pass’ or ‘
get through.’  This is similar to turning down the treble knob on a stereo. 

Low Pass Cutoff: The cutoff represents a frequency value is between 0% and 100%.  The default is 
100% and means you hear all frequencies in the sound.  0% equates to a very low cut off frequency and 
you would not hear any sound. 

Low Pass Resonance:  As this value increase, the overtones near the cutoff frequency are boosted. 
The result is that the cutoff frequency is much louder than the rest of the audio being filtered.  

IMPORTANT: The Low Pass Cutoff works hand in hand with the Low Pass Resonance.  The Low Pass 
Resonance setting will not be audible if you haven’t adjusted the Low Pass Cutoff! 

Tips:

� To use the resonant filter creatively, try a resonant filter sweep.  To do this, set the Resonance 
envelope at 200 and create a Cutoff envelope that rises and falls slowly.  Since the resonant 
value is relatively high (200), as the cutoff goes up and down you should distinctly hear the 
"resonant peak" follow the cutoff, with its characteristic sound.  For example, the famous 
wah-wah pedals used by guitarists, makes use of resonant filter sweeps back-n-forth, with the 
cutoff controlled by the foot pedal.

� If the resonant setting is cranked all the way up to 256, the filter goes into a state called 
"self-oscillation" and produces a ringing-whistling tone. ATTENTION: this can be very loud and 
overwhelming, so please watch your audio levels as it can be dangerous for your ears and your 
speakers!!

� Using resonant filter sweeps on synthesizer melody lines can make some very musically 
compelling timbre and tone changes, to signal a transition, a buildup or a bridge.

* The cutoff % is a mapped logarithmically from 200 Hz to ½ sample rate.



High Pass Cutoff & High Pass Resonance
The High Pass Cutoff limits the low frequencies that are played.  It lets the high frequencies ‘pass’ or ‘
get through.’  This is similar to turning down the bass knob on a stereo. 

High Pass Cutoff:  The high pass cutoff value represents a frequency between 0% and 100%.  The 
default is 0%, which allows all frequencies to pass. 100% is essentially silent and does not let any high 
frequencies be heard.

High Pass Resonance:  As this value increase, the overtones near the cutoff are boosted. The result is 
that the cutoff frequency is much louder than the rest of the audio being filtered.  

IMPORTANT: The High Pass Cutoff works hand in hand with the High Pass Resonance.  The HIgh 
Pass Resonance level will not be audible if you haven’t adjusted the High Pass Cutoff! 

Tips:

� To use the resonant filter creatively, try a resonant filter sweep.  To do this, set the Resonance 
envelope at 200 and create a Cutoff envelope that rises and falls slowly.  Since the resonant 
value is relatively high (200), as the cutoff goes up and down you should distinctly hear the 
"resonant peak" follow the cutoff, with its characteristic sound.  For example, the famous 
wah-wah pedals used by guitarists, makes use of resonant filter sweeps back-n-forth, with the 
cutoff controlled by the foot pedal.

� If the resonant setting is cranked all the way up to 256, the filter goes into a state called 
"self-oscillation" and produces a ringing-whistling tone. ATTENTION: this can be very loud and 
overwhelming, so please watch your audio levels as it can be dangerous for your ears and your 
speakers!!

� Using resonant filter sweeps on synthesizer melody lines can make some very musically 
compelling timbre and tone changes, to signal a transition, a buildup or a bridge.

* The cutoff % is a mapped logarithmically from 200 Hz to ½ sample rate.



Effects Dialog
Mixcraft™ comes with 7 default effects, which are used for the Main FX and track FX.  Click a track’s 

FX button or the "Main FX" button to bring up the Effects dialog.  Note that you can use all features of 
Mixcraft while the effects dialog is up, which includes playback controls!

Adding an effect

Choose an effect from the drop down list on the left side.  This will add an instance of the effect to the 
"Effects Chain List."  Note that you can add more than one instance of any effect.  For example, you 
could have 2 delays and 2 choruses.  Also, keep in mind that adding effects should be done cautiously 
as it tasks the capabilities of your computer’s processing power.

Previewing Effects

To hear an effect, simply select Play from the Mix menu or the toolbar.  Adjust the effects in real time as 
the sounds play.  (You do not need to close the effect dialog while it is playing!)

Effects Chain List

Each effect dialog has a list of effects, also called the "Effects Chain List".  The effect chain allows you 
to ‘chain’ or connect multiple instances of delay, reverb and others to the same track or to the Main FX.  

 The top of the list is the first effect. 

Disabling & Muting Effects

Each effect on the Effects Chain List has a check box, which allows you to mute, and un-mute effects.  
This is a convenient way to determine the difference the particular effect makes.

Reordering Effects

Each effect on the Effects Chain List is processed from top to bottom.  You can reorder the list by 
clicking on an effect and dragging it, or by selecting the effect and clicking "Up" or "Down".

Deleting Effects

Select an effect and click "Delete" and it will be removed from the Effects Chain List.

** 3rd Party VST & DirectX Effects **
Mixcraft will use 3rd party audio effects to further warp/modify your sounds.  These third party effects 
will include: Vocal Removers & Isolaters, De-essers, Delay, Echo, Distortion, Overdrive, Amplifier 
simulators, Compressors, Limiters, EQ, Exciters, Enhancers, Filters, Gates, Imaging, Panning, Lo Fi 
effects, Mastering plugins, Modulaters, Flangers, Chorus, Tremelo, Noise Removal, Restoration, Pitch 
Shifters, Reverb, Ring Modulators, Spectral Processors, Tuners and Vocoders to name a few!  Find 
More VST & DirectX Effects Here.   You will be able to access these 3rd party effects through the 
effects dialog.

� Add more VST folders by clicking Preferences, selecting the "Miscellaneous" tab and then 
clicking "Edit VST Effect Folders…"  Click ‘Add’ to add a specific folder to scan for VST 
effects.  (VST effects files end in .DLL.)  You may also click the ‘Auto-Scan’ button to search 
for directories that have the word ‘vst’ in them.

� Excluding specific VST or DirectX effects. 



Built In Acoustica Effects Include:

Delay 

Reverb 

Chorus 

EQ 

Flanger 

Compressor 

Distortion 

 



Delay is used to create an echo effect.  It is a delayed copy or copies of the sound, usually at a reduced 
volume.

Delay

This parameter specifies how long to delay a copy of the sound.  You can choose from 1 millisecond to 
2000 milliseconds (2 seconds.)   (There are 1000 milliseconds in a second.)

Feedback

This parameter specifies how much of the delayed signal gets delayed again.  This will create the 
illusion of multiple echoes.  You can choose from 0% to 95%.  0% would be result in 1 echo, whereas a 
setting of 95% would result in many echoes.

Pan

This parameter specifies where the delayed sound will be in terms of the stereo field.  Choose from the 
left speaker, center or the right speaker.

Wet Mix

The wet mix is the new sound created by this effect.  This specifies how much of the delay that you 
hear. You can choose from 0% to 100%.  0% is the same as muting the effect and 100% would result in 
a maximum delay.

Dry Mix

The dry mix is the original sound.  This specifies how much of the original sound that you hear.  You can 
choose from 0% to 100%.  0% would result in no original sound and 100% would result in a 100% of the 
original sound.

Tips

� Use for special psychedelic effects. Turn up the feedback.

� Use at a short offset for a drum loop that is in time with the loop.

� Accentuate vocals or guitars with a short echo.  This can be especially useful on electric lead ‘
guitaring’ such as used on some Pink Floyd songs.



Chorus is an effect usually used to create a ‘fuller’ sound by doubling and modulating the sound.  It 
thickens the sound by doubling it and slowly varying the time offset of the copy.

Delay

This parameter specifies how long to delay the copy of the sound.  The range is from 10 milliseconds to 
50 milliseconds.

Rate

This parameter controls how fast the doubled sound  goes in and out of tune.  The range is from 0.1 Hz 
to 2.0 Hz.  

Intensity

This parameter controls how much the doubled sound is out of tune.  The range is from 0.01 ms to 10 
ms.

Wet Mix

The wet mix is the new sound created by this effect.  This specifies how much of the chorus that you 
hear. You can choose from 0% to 100%.  0% is the same as muting the effect and 100% would result in 
a maximum chorus. 

Dry Mix

The dry mix is the original sound.  This specifies how much of the original sound that you hear.  You can 
choose from 0% to 100%.  0% would result in no original sound and 100% would result in a 100% of the 
original sound.

Tips

� Use for vocals to give the illusion of multiple singers.

� Use strong chorus intensity for a strange warbly effect.

� Use on instruments such as keyboard or organ for a more full sound.

� Use multiple instances of chorus at slightly different settings for more than one doubled voice.



EQ or equalization allows you to lower or raise the volume of specific frequency ranges.  This effect is 
comparable to the graphic equalizer control commonly found on stereo amplifiers.  The Acoustica EQ 
effect can subtly color the sound or give you a dramatic change, from a low-fidelity sound of AM Radio 
to subtle mid-range boosts on a vocal recording. 

EQ bands

You can change the amplification for 10 frequency bands by 18 dB.  The bands represent 32 Hz, 63 Hz, 
125 Hz, 250 Hz, 500 Hz, 1 kHz, 2 kHz, 4 kHz, 8 kHz & 16 kHz.

Output Gain

This allows you to raise or lower the equalized sound.  In some cases, a particular equalization might 
cause distortion and, thereby, you’d want to reduce the output gain.

Reset

This resets all frequency bands to their center position and the output gain to 0.  This is the default 
position and is the same as muting or disabling the EQ.

Tips

� Choose the "Telephonic" preset to make your mix sound like its going through a telephone.

� Choose the "Lo-Fi" or "1960s" preset to make your mix sound like its on a cheap TV.

� Try to avoid over equalizing.  Not all speakers are created equal.  For example, if you boost the 
bass real high, many systems may not be able to play it properly.  Aim for the common 
denominator speakers.  Of course, if you are making a mix for a dance club, give it some more 
bass and then give it some more. ☺

* EQ note:  If you are playing back sounds with lower sample rates such as 22,050 Hz or 11,025 Hz, some of the higher bands 
will not have any audible effect as it is impossible to contain frequencies above ½ the sampling rate.  (An 11,025 Hz sound 
cannot contain frequencies above  5,012 Hz (Nyquist’s theorem) )



The Flanger is similar to Chorus, except that it has a feedback setting.  According to legend, the flanger 
was born when the Beatles were in the studio producing an album.  A tape machine was being used for 
an echo effect, when someone touched the rim of the reel, changing the pitch.  After a bit of fiddling and 
mixing of signals, that characteristic flanging sound was born.  The rim of the reel is also known as the 
"flange", hence the name. ☺

Delay

This parameter specifies how long to delay the copy of the sound.  The acceptable range is from 0.1 
milliseconds to 20 milliseconds.  This controls the intensity of the effect.

Feedback

This parameter specifies how much of the flanger sound is ‘re-flanged’ and sent back into the Flanger 
effect.  The acceptable range is from 0% to 95%.

Rate

This parameter specifies how fast the flanger ‘whooshes’ up and down.

Wet Mix

The wet mix is the new sound created by this effect.  This specifies how much of the Flanger that you 
hear. You can choose from 0% to 100%.  0% is the same as muting the effect and 100% would result in 
a maximum Flanger. 

Dry Mix

The dry mix is the original sound.  This specifies how much of the original sound that you hear.  You can 
choose from 0% to 100%.  0% would result in no original sound and 100% would result in a 100% of the 
original sound.

Tips

� Use the "Classic" preset it to create a whooshing effect on sustaining sounds, such as 
vocals, pads.

� Increase the feedback and rate to create a weird warpy sound effect.  "Insane Membrane" 
is a good warpy preset.



The compressor is one of the least glamorous effects and one of the least understood.  However, it can 
be very POWERFUL when used properly.  The compressor makes the dynamics more even.  The low 
volume sounds become louder and the high volume sounds become lower.  Compressors are used 
extensively in studio recordings, radio production and for live performances.

Compressors work by using an audio level sensing function to keep track of the sound level.  When the 
sound level gets too high for the right amount of time, it is reduced.  Once it is reduced, the entire signal 
can be amplified, allowing you to hear the low volumes better.

The image above shows an original sound.  Notice the big difference between the peaks and valleys of 
the sound.

The image above shows the sound with the Compressor effect on.  Notice that it is a stronger &  ‘fatter’ 
sound and the peaks and valleys are closer together.

Threshold

The audio  level where sound is compressed.  This effect is in dB .  The range is from 0 dB to –30 dB.  
–30 dB represents the strongest threshold with the most amount of compression. 

Attack time

This sound level needs to be above the threshold level for this amount of time in order to be 
compressed.  The valid settings are from 0.01 milliseconds (ms) to 150 milliseconds.

Release time

The release time is the length in time to restore the audio signal from being compressed back into its 
normal state.  The valid settings for the release time are from 10 milliseconds to 500 milliseconds.

Ratio

This parameter indicates how much to compress once it is passed the threshold.  The valid range is 
from 1 to 35.  A value of 1 is no compression and 35 is the maximum amount of signal compression.

Output Gain

This parameter adjusts the output gain of the compressor.  Note that this amplification will be in addition 
to automatic volume adjustments via the "Auto Gain Compensator".



Auto Gain Compensation

This will automatically adjust the gain on the compressed sound in addition to the "Output Gain" setting 
above.  Auto Gain Compensation boosts the audio signal to full strength.  (Depending on the audio, you 
may need to additionally raise or lower the output gain.)

Tips

� Vocalists/Singers: Apply compression to even out the volume changes if the singer is moving to 
and from the microphone.

� Presence booster:  Instead of applying EQ, you might try adding a compressor to vary tone 
quality of a recorded instrument.

� Guitar / plucked sustain increase:  Normally, after a guitar string is plucked, the sound dies 
away.  Light compression with a long release will increase the sustain.



The Distortion effects adds very harsh harmonics to the tone, simulating the effect of a guitar distortion 
pedal on the sound.  A small amount of distortion will add a bit of 'bite' and compression to the sound.  
A large amount of distortion will change practically any tone into a nasty, overdriven sound.

 

The distortion effect has three controls:

 

Pre Gain sets the amount of volume that is sent into the distortion effect, from 1 to 200 percent.  
Sending greater than 100% of the signal into the distortion effect will cause even greater amounts of 
distortion to be generated.

 

Distortion sets the amount of actual distortion that is applied to the original sound, from 1 to 200 units.

 

Post Gain sets the volume of the signal after distortion has been applied.  This control is useful for 
taming peaks that may occur because of distortion, to keep the post-distortion signal from clipping.



Effects Dialog
Mixcraft™ comes with 7 default effects, which are used for the Main FX and track FX.  Click a track’s 

FX button or the "Main FX" button to bring up the Effects dialog.  Note that you can use all features of 
Mixcraft while the effects dialog is up, which includes playback controls!

Adding an effect

Choose an effect from the drop down list on the left side.  This will add an instance of the effect to the 
"Effects Chain List."  Note that you can add more than one instance of any effect.  For example, you 
could have 2 delays and 2 choruses.  Also, keep in mind that adding effects should be done cautiously 
as it tasks the capabilities of your computer’s processing power.

Previewing Effects

To hear an effect, simply select Play from the Mix menu or the toolbar.  Adjust the effects in real time as 
the sounds play.  (You do not need to close the effect dialog while it is playing!)

Effects Chain List

Each effect dialog has a list of effects, also called the "Effects Chain List".  The effect chain allows you 
to ‘chain’ or connect multiple instances of delay, reverb and others to the same track or to the Main FX.  

 The top of the list is the first effect. 

Disabling & Muting Effects

Each effect on the Effects Chain List has a check box, which allows you to mute, and un-mute effects.  
This is a convenient way to determine the difference the particular effect makes.

Reordering Effects

Each effect on the Effects Chain List is processed from top to bottom.  You can reorder the list by 
clicking on an effect and dragging it, or by selecting the effect and clicking "Up" or "Down".

Deleting Effects

Select an effect and click "Delete" and it will be removed from the Effects Chain List.

** 3rd Party VST & DirectX Effects **
Mixcraft will use 3rd party audio effects to further warp/modify your sounds.  These third party effects 
will include: Vocal Removers & Isolaters, De-essers, Delay, Echo, Distortion, Overdrive, Amplifier 
simulators, Compressors, Limiters, EQ, Exciters, Enhancers, Filters, Gates, Imaging, Panning, Lo Fi 
effects, Mastering plugins, Modulaters, Flangers, Chorus, Tremelo, Noise Removal, Restoration, Pitch 
Shifters, Reverb, Ring Modulators, Spectral Processors, Tuners and Vocoders to name a few!  Find 
More VST & DirectX Effects Here.   You will be able to access these 3rd party effects through the 
effects dialog.

� Add more VST folders by clicking Preferences, selecting the "Miscellaneous" tab and then 
clicking "Edit VST Effect Folders…"  Click ‘Add’ to add a specific folder to scan for VST 
effects.  (VST effects files end in .DLL.)  You may also click the ‘Auto-Scan’ button to search 
for directories that have the word ‘vst’ in them.

� Excluding specific VST or DirectX effects. 



Built In Acoustica Effects Include:

Delay 

Reverb 

Chorus 

EQ 

Flanger 

Compressor 

Distortion 

 



Mix Down / Mastering
You’re done and ready to mix it down to a single file or multiple files!  Congratulations!  Mixcraft 
currently supports mixing down to WAV, MP3, WMA and Realaudio.  Choose "Mix Down To" from the 
"File" menu and then choose the format you are interested in.

WAV 

WAV files are the most widely supported file types.  Unfortunately, these are also the largest file type.  
This would be the best option if you are burning audio CDs.  More on exporting to WAV 

MP3 

MP3 files are the most popular way of encoding sound at this time.  This would be the best option if you 
are sending your MP3 files to the Internet, are creating an MP3 data cd, or are sending them to a 
portable MP3 device.  More on exporting to MP3 

Realaudio™ 

Realaudio files were the first highly compressed file format to hit the Internet.  Choose this option if you 
wish to create a realaudio file for streaming over the Internet.  More on exporting to Realaudio. 

WMA 

WMA files are Windows Media Audio files.  This is a smaller and compact alternative to MP3 files.  It is 
not as widely supported as MP3 files are but, since this is the Microsoft format, it has a funny way of 
becoming more popular every day. ☺  More on exporting to WMA 

OGG 

OGG is a royalty and patent free compression.  This is a small and compact alternative to MP3 and 
WMA.  More on exporting to OGG. 

 

Burn A CD 
Burn your mix to a CD or burn a selection of sound to CD!



Mix Down to a WAV file

WAV files are the most widely supported file types.  Unfortunately, these are also the largest file type.  
This would be the best option if you are burning audio CDs.

� Destination File Size - This is a helpful indicator that estimates how big the destination file size 
is going to be.  

� Render All/Selection - The default is to render the entire session.  However, you can also 
render the current selection.  You might choose to render the selection if you want to hear how 
it sounds under a certain sample rate, bits and stereo combination.  (You wouldn’t have to 
render the entire session which could take a while depending on the length of the session.)

� Sample rate – enter or select a sample rate.  CD quality is 44,100 Hz.  If, in doubt, choose 
44,100 Hz.  Selections include 8 kHz to 192 kHz, but you may type in any sample rate.

� Bit depth – choose from 8, 16, 24, 32 or 32 bit float.  CD quality is 16 bits.  If, in doubt, choose 
16 bits.

� Channels – choose from Mono or Stereo.  CD quality is stereo.

� User Information – Enter in the title, author and copyright if desired.

� Create a separate WAV for each track marker – This option will be enabled if you have more 
than one CD Track Marker.  If you select this option, Mixcraft will create a WAV file for each 
section of audio.  More on track markers 



Mix Down to a MP3 file

MP3 files are the most popular way of encoding sound at this time.  This would be the best option if you 
are sending your MP3 files to the Internet, are creating an MP3 data CD, or are sending them to a 
portable MP3 device.

� Destination File Size - This is a helpful indicator that estimates how big the destination file size 
is going to be.  It is an approximation, though, especially when rendering to variable bit rate 
MP3 files which depend on the actual audio content.

� Preset Quality - Adjust the slider and choose one of the presets to set the desired MP3 quality.  
More info on presets …

� Specify Exact Settings - You can also set the exact format to encode to.  For example, if you 
want to create a variable bit rate MP3, you’ll need to use this option.  More on setting the 
specific encoding settings 

� File Information – Mixcraft adds authoring information to the MP3 file.  It creates an ID3V1 and 
ID3V2 tag by default.  You can fill in the Title, Author, Copyright, Genre, Year and Comment.

� Create Separate MP3 File For Each CD Marker? This option will be enabled if you have more 
than one CD Track Marker.  If you select this option, Mixcraft will create an MP3 file for each 
section of audio.  More on track markers



Mix Down to a WMA file

WMA is a second-generation compressed audio format. 

From the "File" menu, select "Mix Down To" and then select "WMA File…" from the submenu.  Pick a 
name for your new WMA file. ( If you are going to be saving multiple WMA files for each CD Track 
Marker, this name will be the base name. )

After a name or base name is chosen, you need to set up extra parameters for the WMA file.   Once all 
the settings are made, click the Save button to render the session to a WMA file.  After it is finished, it 
will play the sound back via your default WMA player.

o Destination File Size - This is a helpful indicator that estimates how big the destination file size 
is going to be. 

o Render All/Selection - The default is to render the entire session.  However, you can also 
render the current selection.  You might choose to render the selection if you want to hear how 
it sounds under a certain compression.  (You wouldn’t have to render the entire session which 
could take a while depending on the length of the session.)

o Preset Quality - Adjust the slider and choose one of the presets to set the desired MP3 quality.  

The possible settings are:

Preset Bit rate Mode Frequency Response

===== ====== ===== ==================

1 16 kbpsMono 8,000 Hz

2 32 kbpsStereo 22,050 Hz

3 48 kbpsMono 44,100 Hz

4 64 kbpsStereo 44,100 Hz

5 96 kbpsStereo 44,100 Hz

6 128 kbps Stereo 44,100 Hz  (default)

7 192 kbps Stereo 44,100 Hz

o Entering File Information – Mixcraft adds authoring information to the WMA file.  You can fill in 
the Title, Author, Copyright, Genre, Year and Comment.

o Create Separate WMA File For Each CD Marker? - This option will be enabled if you have more 
than 1 CD Track Marker.  If you select this option, Mixcraft will create a WMA file for each 
section of audio.  More on track markers



Mix Down to a Realaudio file
IMPORTANT: If you can not create Realaudio files, then you must download and install the optional 
Realaudio plugin from Acoustica @ http://www.acoustica.com/ 

From the "File" menu, select "Mix Down To" and then select "RealAudio File…" from the submenu.  
Pick a name for your new RealAudio file. 

What is RealAudio™ ?

RealAudio is an audio format, which is highly compressed and small, allowing for real time streaming of 
audio over the Internet.  RealAudio is a proprietary technology owned by RealNetworks, Inc.  The latest 
version of RealAudio is called G2.  Its main feature is called SureStream, which allows for multi-rate 
RealAudio files.

Exporting to RealAudio™.

One of the convenient features of Mixcraft is the ability to instantly render the session into a RealAudio 
file. Simply select Save As.. from the File menu and change the file type to RealAudio™.   Select a 
filename and select the Save button.  This brings up the following dialog… There are several factors to 
consider.

SureStream vs. Single Rate

SureStream is RealNetwork’s multi-format file.  It’s the most important feature of G2.  You can create a 
SureStream file that will work with people connecting through a LAN, in addition to people with bit-pushin
’ 28.8 modems!   The people with the higher speed connection will be served higher quality audio, while 
the people with the lower speed connection will be served the "less than perfect" audio.  You can have 
up to six target audiences.

What’s the catch?  You need a RealServer G2 for playback!   (Your ISP may have a RealServerG2 
already setup.)

o Pressing ‘Preview’  will automatically render the first 5 seconds of the session with the selected 
codec .

o Pressing ‘Fine Tune ’ will bring another dialog, which allows you to fine-tune the selected codec in 
case the preset codecs don’t sound good.

o Selecting the "Create RealPlayer 5 Compatible Clip" will allow the older RealPlayer 5.0 players to 
play the clip.  It will make the clip slightly larger.

o Single rate files can also be created.  These files can also be streamed via a traditional web server, 
just as if you were downloading a file. 

o Pressing ‘Preview’  will automatically render the first 5 seconds of the session of the current codec.

o Pressing Fine Tune will bring another dialog, which allows you to fine-tune the current codec in case 
the preset codecs don’t sound good.

Target Audience

Who is the target audience?  Perhaps, you have a lot of corporate visitors with LANs, but you also have 
56K modem users.  You might select 2 target audiences (56K Modem and Corporate LAN).  



You can select up to 6 different target audiences if you are creating a SureStream.  If you are creating a 
single rate file, you can only select one target audience at a time.

Content Type

This one is pretty self-explanatory.  Is your masterpiece music or voice?  Or is it voice with background 
music?  If the stereo separation is an important part of the piece, you might select "Stereo Music".  The 
most important test is to simply listen to how it sounds in the various settings.  The preview feature 
makes it very easy to do this.  Take advantage of it.

If you are going to eventually include this with a RealSlideshow™ or a RealVideo™, you should uncheck 
the "Audio Only?" checkbox which will adjust any selected codecs.  (It will lower the bit-rates to 
accommodate other data being downloaded.)

Render All or Selection

One of the cool features of Mixcraft™  is that you can render selections anywhere in your session.  
Select some sounds and press the RealAudio button.   Now you can press the "Render Selection" radio 
button, which will enable you to render the current selection!  This can be very handy if you are curious 
how a particular segment sounds, but you don’t want to render the entire one hour piece!

Clip Information

This is the information that is stored with the clip.  The name of the clip will default to the name of the 
main Sound Group.  The copyright and author information will default from the Miscellaneous 
information tab in the Preference dialog.

RealAudio Fine Tune Dialog

If you choose to fine-tune a codec, it will bring up this dialog (fig17b).  You may choose a different codec 
and preview it.  The bit-rate, frequency response, compatibility information and a detailed description 
are displayed as you switch between different codecs.  It will not allow you to exceed the maximum 
bit-rate for the target audience you are tuning.

Note: It may take awhile for the RealAudio file to be completely rendered, depending on the power of 
your computer and the length of the session.  You may hit the cancel button to escape a lengthy 
encoding.

Creating the RealAudio File (.ra)

After you are happy with the settings, you should press the Save button on the main RealAudio dialog.  
Pick a filename and press "Save".  It may take awhile for the RealAudio file to be completely rendered, 
depending on the power of your computer and the length of the session.  You may hit the cancel button 
to escape a lengthy encoding.  By default, after it is finished encoding, it will play the newly rendered file.

Optimizing your sound for RealAudio™

You may be wondering, "how can I improve the way that my RealAudio files sound?"  The rule of thumb 
is to not make your Sound Groups too quiet. If you feel they are too loud, simply turn your speakers 
down.  You will notice substantial improvements if the volume levels are kept as high as possible. 

If you have an external editor that can "compress" the sound, this may also help for RealAudio 
conversion.  This is not the file type compression.  This is referring to dynamic amplitude compression.  



Basically it takes the low parts of your sound and makes them louder, as well as taking the loud parts 
and making them quieter.

Uploading it to the Internet.

Mixcraft™ does not upload or publish the file to the Internet by itself.  You will find that most WEB page 
creation programs have this type of feature built in.  You may also choose to use a ftp program to 
upload the RealAudio file.  

Check the "Links" page on Acoustica for some links to sites that have useful information on uploading 
RealAudio files!



Mix Down To OGG File

OGG files are a new way of encoding sound.  This would be the good option if you were sending your 
OGG files to the Internet because OGG files are royalty free and are small in size.

� Destination File Size - This is a helpful indicator that estimates how big the destination file size 
is going to be.  It is an approximation, though.

� Preset Quality - Adjust the slider and choose one of the presets to set the desired OGG quality. 
This convenient slider allows you to quickly choose from a list of various configurations.

Preset Bitrate Channels

========== ====== ========

Voice Quality 64 kbps Mono

FM Quality 96 kbps Stereo

Tape Quality 128 kbps Stereo

Hi-Fi Quality 160 kbps Stereo

CD Quality 192 kbps Stereo

Studio Quality 256 kbps Stereo

Best Quality 250 kbps Stereo

� Specify Exact Settings - You can also set the exact format to encode to.  This allows you to set 
the specific bit rate, channels and either Average or Variable bit rate.

Average Bit Rate – Choose this to set the average bit rate. 

Variable Bit Rate – Choose this to set the variable bit rate.  Change the slider to set the 
quality from 1% to 100%

Mode – Choose mono or stereo in either Average or Variable Bit Rate mode

� File Information – Mixcraft adds authoring information to the OGG file.  You can fill in the Title, 
Author, Copyright, Genre, Year and Comment.

� Create Separate File For Each CD Marker? This option will be enabled if you have more than 
one CD Track Marker.  If you select this option, Mixcraft will create an OGG file for each section 
of audio.  More on track markers



Burn A CD
If you’re recording your LPs or cassettes to CD or if you’re ready to cut your hit record, burn an audio 
CD directly in Mixcraft!   Select "Burn CD…" from the "Mix" menu or click the CD icon on the toolbar.  

TIP: To use an 80-minute CD, make sure to put the blank CDR in the drive before starting the Burn CD 
window.

TIP 2: ALWAYS SAVE YOUR MIX BEFORE BURNING!!

Mixcraft allows you to burn the entire mix or a selection.  You are limited to 74 or 80 minutes of audio 
per CD.  If you have a mix that is longer that 74 or 80 minutes, you can select the first 80 minutes and 
burn it, select the next 80 minutes and burn it, and so on!

Mixcraft will use the track markers to decide where tracks start and end.  (Note that the track marker 
must have the CD Track option checked.)

Click "Start Burn!" to burn your CD!

Writer
If you have more than one CD or DVD recorder, you can select it here.

Speed
Select a speed from 1X to Fastest.  1X would be the same speed as it takes to play it back.  So if it 
were a 50-minute recording, it would take 50 minutes to burn at 1X.

Test Mode
If checked this will cause the burner to simulate or test a burn.  It will help to make sure that your 
system is ready to burn CDs.  It’s not a bad idea to try this before doing an actual burn.  (This does not 
use a blank CD, of course.)

Convert To WAV First
If your computer is slow or you have a very complicated mix, you may want to check this before 
burning.  It will cause the mix to be converted to WAV files before it starts the burn stage.  (Note that if 
you are burning a 74-minute CD, you will need 650 MB free at least.)

Burn As One Track
Select this option if you only want to burn one track and do not want it to use the track markers.  (If you 
are using IMAPI with the mandatory 2 second gap, this allows you to keep the original recording intact 
but it will not be track seek-able on CD players)

Create CD-Text
If your CD recorder supports it and you are not using IMAPI, you can name the CD so that the title 
shows up on CD-Text enabled players.  (It will use the CD track marker names as the track titles.)  Type 
in a title if you check this option.

Burn All Or Current Selection



All CDs are limited to 74 or 80 minutes, depending on the size of your blank CDs.   If "All" is checked, 
the software will burn the first 74 or 80 minutes.  If "Current Selection" is checked, the software will burn 
the first 74 or 80 minutes of the selection.  (Before clicking "Burn CD.." make sure to select the area you 
want to burn.)

Start Burn
Click this to start the burn.  It will prompt you for a blank CD and show the burn progress.  You can abort 
the burn by clicking "Cancel" at any time.  

At the end of the burn, it will ask you if you want to create a CD label with the optional but highly 
recommended Acoustica CD/DVD Label Maker.  

ISRC Mastering

For those advanced users that are creating master CDs to be made commercially, you can add track 
ISRC codes on each track marker.  If you have entered the ISRC codes in your track markers, it will 
burn these identifiers to audio CD.
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Playback Preferences
If you have more than one soundcard, you can choose the soundcard you want for playback in the 
Playback device drop down at the top of window.

If you select Use Best Quality, Mixcraft will always use the best sound format in the session as the 
default sound format.  Choosing this option will ensure that you don’t have any sound degradation.  

You may, instead, choose to use a specific format.  Wave formats have the following characteristics:

• Sample Rate

Sample rate simply means the number of times per second that the computer plays or records 
a snapshot of the sound.  Faster sample rates catch faster frequencies.  You may set the 
format to the following sample rates : 11,025 , 22,050, and 44,100, or you may type in a sample 
rate.

• Bits Per Sample

This determines the quality of each snapshot.  The more bits, the better.  You may set the 
format to either 8, 16 or 24.  (8 has a tendency to sound fuzzy)  24 bit playback is new to 
version 1.1.  Note that not all soundcard’s will support 24 bit playback.

• Number of channels

Is it stereo or mono?  Setting the format to mono, will essentially disable panning.

The advanced section allows you to change the number of buffers and buffer size.  Without getting too 
complicated, you use these options to find a balance between audio discontinuity and playback latency.

Latency is the amount of time it takes from the time you press the Play to the time you hear the sound.  
If you feel the latency is to big, try reducing the number of buffers or the buffer size.

Audio discontinuity is sometimes described as "popping" or "static".  The audio will drop in and out.  If 
you have audio discontinuity problems, try increasing the number of buffers and/or the buffer size.



Recording Preferences
Use the recording preferences to set the recording sample rate and other recording specific settings.

� Full Duplex Test: Take this test to make sure that you can play and record sound at the same 
time.

� Recording Settings

o Sample rate: This is the number of times per second that an audio sample is recorded.  
CD quality is 44,100 samples per second.

o Bit depth: 8,16 or 24 bits?  8 bit sound has a real high signal to noise ratio and sounds 
pretty noisy, especially for subtle and lower volume sounds.  If in doubt, choose 16 bits.  
24 bit recording had just been added in version 1.1.  This is a very high quality setting.  
Many soundcards do not support 24 bit.  Choose this option if you are concerned about 
the highest quality possible.  (24 bit sounds are also large.)

o Channels: Stereo or mono?  If you are doing a lot of mono recordings and wish to cut 
down on hard drive space, choose mono.  Mono sounds are 2 times smaller than 
stereo sounds.

� Advanced Settings

o Number of buffers: This is the number of buffers sent to the soundcard to be filled up 
with sound data.  Some soundcards work better with more buffers.

o Buffer size: This specifies the size of each buffer, in terms of kilobytes (KB).  Use larger 
buffers to reduce the change of losing parts of your recordings.  .  If you find that your 
recordings are missing sound or have static glitches, try increasing the number of 
buffers and/or the buffer size.   

� Ask To Save Recordings?  If checked the software will ask you to preview a sound after 
recording and then ask you to save it to a new file.  If this is unchecked, the recording process 
is much faster.  (Note that if you don’t want a recording, simply click Ctrl+Z or select Undo from 
the Edit menu)

� Recording Directory: This is where recordings will be saved.  Make sure you have enough free 
space on the hard drive that your recording directory is on.  If you want to record using your 
computer’s RAM, clear all characters from the edit box so that it is empty.  You should see 
"(RAM)" displayed above and then hit "OK".



Information Preferences

The name, and copyright fields will automatically appear when rendering the session to a RealAudio™ 
MP3, WMA or Wave file.  This saves you the trouble of having to type it every time you want to export or 
render a file.

� Author – Generally, this should be the organization or person who creates the audio mixes.

� Copyright – This should be the copyright for the author or organization that does the creating.

� Comments – These comments will be inserted into the comments section of your mixes.



Miscellaneous Preferences

� Auto scroll during playback. - Normally, during playback if the indicator gets near the right end of the 
window, the view is scrolled over in time.  This option allows you to turn that off or back on.

� Start playback at beginning when near end - Normally, if the session has played to the end, starting 
playback again will also cause the session to rewind to the beginning.  This option allows you to 
toggle the behavior.

� Wave Display Resolution- Mixcraft can operate faster because it doesn’t load in a pixel for every 
sound sample.  It defaults to 1 milliseconds per pixel.  You can configure it to be anywhere from 1 
millisecond per pixel to 100 milliseconds per pixel.

� Setting the playback indicator when clicking in the session window - If you click within the main 
window, this will cause the playback indicator to be set.  Normally, this only sets the caret (paste 
point).  If you are currently playing, it will restart playback from this position.

� Load DirectX Effects – Check this if you want DirectX effects to load.  You may want to uncheck it if 
you don’t use DirectX effects and want to speed up the initial splash screen load time.  Changes 
take place after you restart the software.

� Load VST Effects – Check this if you want to load VST Effects.  Changes take place after you 
restart the software.

� Edit VST Effect Folders…  - You can add more folders to be searched for VST effects.  VST effects 
are .DLL files that allow you to shape and warp sound beyond the standard Acoustica effects.  Add 
or scan for new directories or remove them.  More On VST Effects.. 

� Play exported files after being created - After exporting a new file, this will automatically play back 
your freshly created sound.  Thus, you can preview it to make sure it sounds correct.

� Editing sounds in an external editor. - If you want to edit sounds in an external editor, you need to 
select an external editor executable that MP3 Audio Mixer launches.  You can either type in the full 
path to the sound editor or press the Browse button to find it through Windows file system.

� Temporary Files Directory – This is where all temporary cached peak (.IPK) and seek (.ISK) files 
are stored. 



File Menu
New Project

This menu item clears the Mix.  If the current Mix has unsaved actions, Mixcraft will ask you if you’d like 
to save.

Open Project…

This menu item brings up a standard file dialog, which allows you to find a Mixcraft project file (.MXC) to 
load.  If the current Mix has unsaved actions, Mixcraft will first ask you if you’d like to save.

Add Sound…

This option allows you to add sound to the Mix.

Import Playlist…

This feature allows you to import play lists.  Play lists are simply lists of sounds (MP3s, usually.)  Note 
that this will import Acoustica MP3 CD Burner play lists (.CBS).

Play list types include : m3u, pls, pl, cbs, asx, cl3, cl4, cl5, nra, pya, rcl, rmp, rxp, wax, wpl, wvx, xml, txt.

After selecting a play list to import, the Play List Wizard dialog will come up.  Choose which 
sounds/MP3s to import.  You can set how much overlap there is between the sounds.  Or you can set it 
up to have space between the sounds.  It can also create automatic CD Markers at the start of each 
new sound.  Click the "OK" button to import each sound and generate a mix.  This can be a very handy 
feature if you are a DJ and you have some existing play lists.

Save Project

This menu item saves the Mix as a Mixcraft Project file (.MXC ).  If the Mix has not been saved yet, it 
will bring up a standard file dialog allowing you to pick a filename and folder.

Save Project As…

This menu item allows the user to save the Mix with a different name.  You may elect to use this option 
if you are branching off in several possible sound designs and want to be able to compare them. 

 

Mix Down To…

When you are ready to mix down your Mix, select one of the following formats from the sub-menu. 

Wave File 

MP3 File 

WMA File 

RealAudio™ File. 

Most Recent Files (8)

Mixcraft displays the most recently used Mixcraft Project (.MXC) files here.  It will display the most 
recent 8 MXC files.



Preferences…

This brings up the Preference dialog. 

Exit

There’s always a time when you have to turn it off.  You can’t use Mixcraft all the time.  (We don’t mind 
that much, though. ;-) )  

This exits Mixcraft.  It will ask if you want to save, if the Mix needs to be saved.



Edit Menu
Undo

Undo allows you to go back to previous states.  Undo is supported for the following actions.

� Editing sounds & loops

� Editing envelope points

� Effect changes

� Track adjustments

Once you save, the Undo memory is cleared. (Thus, you cannot Undo after saving…)

Redo

Redo is the opposite or Undo.  For example, Sound Warrior adds an envelope point on his 
"angry-war-cry.wav", then decides he doesn’t like it and does an Undo.  Suddenly, he thinks of the 
ancestors looking down upon him and decides to put it back by doing a Redo. ☺

Copy

Copy will take a snapshot of all currently selected sounds & associated envelopes.  Each successive 
Copy command clears the previous copied sounds.   Note that this will copy only the selected portions 
of the sound(s).

Cut

Cut will remove all currently selected portions of sounds and envelopes from the Mix.  It will also copy 
the selected portions of the sound(s) into the clipboard for pasting.  (Don’t worry, remember, you can 
Undo.)

An alternative to Cut, is the ‘Delete’ key.  This will cut all the selected portions of sounds, but will not 
store them in the clipboard.  This is handy if you don’t want to overwrite the contents of the clipboard. 

Paste

Paste will add all Copied sound(s) at the Caret position.

Select All

All sounds will be selected.

Zoom In

Mixcraft allows you to zoom in up to a resolution of 1 pixel = 2 milliseconds.

Zoom Out

Mixcraft allows you to zoom out to a resolution of 1 pixel = 1 second.



Mix Menu
In addition to the menu bar, you can right click in the main session to get this menu.

Add Sound…

This option brings up a standard file dialog allowing you to select a new Wave file (.wav) to include in 
the current Sound Group.  It will appear at the current position of the Caret.

Record Sound…

This option brings up the recording dialog.  You may also select "Ctrl+R" to bring up the recording 
dialog.  More on recording …

Add Track

Burn CD…

This will launch the CD burning dialog and allow you to burn a CD of your creation.  More on burning 
CDs …

CD Label Maker…
This will launch Acoustica CD / DVD Label Maker if installed.  Note that it will use the track marker titles 
in order to pre-populate the track list for the label maker so that you don’t have to re-type them.  You 
can use the CD label maker to print labels on stickers or print directly to CD using one of the new 
Direct-To-CD printers on the marker!

Mix Info

Mix Info is a dialog that allows you to change the name and associated comments.  It also displays the 
date it was created, its length in time, the number of sounds and a checkbox to display itself on start up.

Play/Stop

This option plays or stops the Main Sound Group.

Rewind

This causes playback to rewind to the beginning of the Main Sound Group.  This can happen during 
playback.

Fast Forward

This causes playback to fast forward to the end of the Main Sound Group.  You may use this option to 
get to the end of the Main Sound Group quickly.

Waveform Display

This brings up a window that shows a more detailed view of playback.  Note that clipping audio will be 
drawn in red.



Sound Menu
You can also use the Sound menu by right clicking on a sound bar.  Make sure that the sound is 
selected first.

Cut (on right click only)

This will remove the sound from the Mix.  (You can always redo to get it back.)

Copy (on right click only)

This will copy the sound and it’s associated envelopes.

Add Sound

This allows you to add a sound or sounds to the mix.  More on Adding Sounds …

Record Sound

This brings up the recording dialog.  You can also press Ctrl+R  More on recording …

Split

This allows you to split a sound clip into two sound clips without cutting any extra audio.  You can also 
press Ctrl+T.  More on Split …

Join

This allows you to join several sounds together, eliminating silence.  You can also press Ctrl+J.  More 
on Join …

Trim Silence
Trims the silence from the start and end of a sound.  You can also press Ctrl+i.

Invert Envelope

This is a helpful function, which changes each pivot point to an opposite or mirrored value.  (This can be 
undone, as well.) IE: For volume envelopes, volumes of 100% will go to 0%.  Volumes of 50% will stay 
the same.  Volumes at 33% will go to 66%, etc.  More on envelopes. 

Reset Envelope

Have you added a billion pivot points to "godly.wav"?  Don’t want to undo everything else that you like, 
but you want to get this sound back to normal.  Simply select this Reset Envelope and it will be set back 
to the very original settings.  This works for each effect type separately, so you don’t have to cleanse 
the volume, if you’ve been mucking around with the Low Pass Cutoff.  More on envelopes.

Fade In

This will fade in the selected part of a sound for the current envelope type.  See more on Envelope 
Tricks & Shortcuts …

Fade Out



This will fade out the selected part of a sound for the current envelope type.  See more on Envelope 
Tricks & Shortcuts …

Boost 20%

This will boost the selected part of a sound by 20% for the current envelope type.  See more on 
Envelope Tricks & Shortcuts …

Reduce 20%

This will reduce the selected part of a sound by 20% for the current envelope type.  See more on 
Envelope Tricks & Shortcuts …

Edit Loop

This launches the loop adjustment window, which allows you to define a looping area for a sound.

Time Stretch…

This allows you to choose a new playback rate for a sound. You will have the option of preserving the 
pitch as well!  More on time stretching … 

Pitch Shift…

This allows you to choose a new pitch for a sound.  More on changing the pitch of a sound …

Edit In External Editor
This will launch a 3rd party single sound editor that allows you to edit the sound or a copy of the sound 
in more detail.  More on external editing …

Muted

This either sets the sound to be muted or un-mutes the sound.  A check mark on the menu item 
indicates that it is muted.

Locked

This is a flag, which tells you if the sound is locked in position.  If it has a check box next to it, it means 
that the sound bar is locked and cannot be moved.  To reposition a locked sound, un-toggle this option.

Play/Stop

This will play the sound if its not playing and stop it when it is.  

Sound Properties

This brings up a dialog with information about the sound, including name, file path, format, length and 
size.  You can rename the sound if it appears to generic looking, ie: "untitled-wav-302123x12.wav" 
could be "john-tooted.wav".  Plus, it gives onlookers a brief laugh. More on Sound Properties …



Markers Menu
(You can also manipulate markers by right clicking on the time line or on a marker.)

Add Marker…
This lets you add a new time line marker.

Edit Marker/ Edit Nearest Marker…

This lets you edit the current marker or the nearest marker to your last click.

Automatic Marker Wizard…

This launches the Marker Wizard dialog which lets you add multiple markers based on the silence in a 
sound or recording or at specific intervals.  More on the Track Marker Wizard …

Play From Previous Marker
This causes playback to start from the previous marker based on the current playback time or last click 
position.  You can also click Ctrl+Shift+[SPACE]

Play From Next Marker
This causes playback to start from the next marker based on the current playback time or the last click 
position.  You can also click Ctrl+[SPACE]

Delete All Markers
This will delete all markers.  (Note that the very first marker cannot be deleted.)



Help Menu

Help Contents

This brings up this file.  (Of course, if you didn’t try that option, you may not ever see this. ☺ )

Check For Update…

This will communicate with the acoustica.com website to determine if a new version is available.  If so, 
you can click a link to take you the download page.

Enter Registration Code

This brings up a window, which allows you to enter your registration information to unlock the software 
into full functionality with no restrictions.

Buy Now!

This either launches a web browser or starts an integrated purchase system.  Once you’ve purchased 
the software, you will receive registration information.

Acoustica Software Products

This has a sub menu of other Acoustica software products.  All products have free trials.  Give them a 
try!  If you like it, you can choose to buy it later!

Download More Effects
This takes you to a page with more VST and DirectX effects to download and install.  You may find a 
vocal remover or a better reverb…check it out! 

About Mixcraft…

This brings up a dialog with some credits, copyright notices and cool artwork.  It also contains the built 
number, which may be important if you are seeking support.



Toolbar

The toolbar allows quick access to common functions.

Create a new Mixcraft project

Open/Load a Mixcraft project

Save

Add a sound (MP3, WAV or WMA)

Play/Stop

Rewind to the beginning

Fast Forward to the end

     Record

Select the active envelope (volume, pan, etc.)

Burn A CD!

Zoom In to the Caret position 

Zoom Out from the Caret position 

Preferences

Purchase the software.  (This goes away, if the software is already purchased.)



Keyboard Controls

Moving Sounds Around (assumes a sound is selected)

(<-  or ->  ) +/- quick move (depends on zoom level.) More.. 

Ctrl + (<-  or ->  ) +/- 20 milliseconds. More..

Ctrl + Shift + (<-  or -> ) +/- 1 millisecond. More..

Moving the Caret Around 

(<-  or ->  ) +/- quick move (depends on zoom level.)

Ctrl + (<-  or ->  ) +/- 20 milliseconds.

Ctrl + Shift + (<-  or -> ) +/- 1 millisecond.

(Up arrow or down arrow) Move the caret between tracks.

Navigating around sounds

TAB Select next sound.  More …

Shift+TAB Select previous sound. More …

[Esc] Deselect any selected sounds.

Playback controls

SPACE  bar Start or stop playback.

SPACE + Ctrl Playback from next timeline marker.

SPACE + Ctrl + Shift Playback from last timeline marker.

 (<-  or ->  ) Minor adjustments of current playback position

[Home] Rewind playback indicator to 0.

[End] Fast forward playback indicator to end of mix.

Other

[Delete] Delete any selection of sound(s).

+ Zoom in.

- Zoom out.

Ctrl+Z Undo.

Ctrl+Y Redo.

Ctrl+X Cut.

Ctrl+C Copy.

Ctrl+V Paste.

Ctrl+A Select All.

Ctrl+N New Mix.

Ctrl+O Open Mixcraft Project…



Ctrl+S Save.

Ctrl+R Launch Record Dialog

Ctrl+J Join Selected Sounds

Ctrl+T Split Sound at Caret

Ctrl+I Trim Silence From selected sound

Nudging Sounds via the Keyboard

You can move sounds via the keyboard. Use the arrow keys to move selected sounds!

Moving horizontally along the timeline.

Use the arrows to move the sound quickly.  

Hold down the Ctrl key and the sounds will move in increments of 20 milliseconds. Hold down the 
Ctrl+Shift key to move in increments of 1 millisecond.

(<-  or ->  ) +/- quick move (depends on zoom level.)

Ctrl + (<-  or ->  ) +/- 20 milliseconds

Ctrl + Shift + (<-  or -> ) +/- 1 millisecond

Moving sounds vertically

You can move the sound vertically as well.  You may do this if you are trying to move sound(s) to 
another track.

Tabbing between Sounds via the Keyboard

If you are interested in getting around quickly in the session and love the keyboard movement features, 
you will be happy to know that you can switch from sound to sound via the Tab key and Shift-Tab key 
combination. 

The Tab key will select the next sound on the current track or the first sound on the subsequent track.  
(If you are at the end of the last track, it will go to the start of the first track.)

Holding down Shift key and pressing the Tab key will do the opposite of Tab.  It will select the previous 
sound on the track.  If it is the first track, it will select the last sound on the previous track.



Troubleshooting

It’s Not Making Any Sound

You’ve added sounds, but you can’t play anything...  There are a few things you can check here.

1. Are the speakers on and plugged in?  (Sorry, management made us ask.)

2. Can you play a Wave file through Windows sndrec32.exe or another sound application?   If you 
can't there may be a problem with your sound card's configuration or drivers.  Refer to your 
soundcard documentation to try to figure out what is wrong.

3. Load the volume control that came with your soundcard and make sure that the Wave device is 
turned up.

4. Another program may be using the Wave device.  Mixcraft will put up a dialog stating that another 
application has the Wave device in this case.

Playback Is Stopping Too Soon!

If you are trying to play sounds in Mixcraft and it seems to cut off too soon or it may have some other 
strange behavior, you should make sure that you have the latest drivers for your sound card.  
Download the latest drivers from your soundcard manufacturer’s website! 

Sound Is Breaking Up / Popping Or Clicking / Lagging

When playing the session, it sounds like someone is starting and stopping the sound real quick, 
repeatedly. This could be because the computer has slowed down due to other programs running at 
the same time. 

Mixcraft has to work harder as the layers of sound increase. Try increasing the buffer size or the 
number of buffers in the Advanced Section of the Preferences Playback tab.

If you are doing a lot of recording and you find that the actual recordings are being broken up, you may 
change the Recording Settings on the Recording tab of the Preference Dialog.

Additionally, you may choose to reduce the # of effects that you are using during recording.  Go ahead 
and mute the effects.  You can always turn them back on later.  (Effects use significant CPU power.)

Another trick is to reduce the number of tracks.  Each track has its own separate mix down which 
costs in terms of your computer’s memory and CPU power.  If you don’t need sounds to be separate 
tracks, try and put them on as few tracks as possible. 

How Do I Cut And Paste Portions Of Sounds?

You know how to copy a whole sound, but how do you copy part of a sound?  Left click on the bottom 
selection area of the sound.  Keep the left mouse button down and then move the mouse over the 
area you want to copy or cut.  A selection rectangle will highlight over the area of the sound.  Then let 
the mouse button up and select "Cut" or "Copy" from the "Edit" menu.  If you are "copying", you can 
then select "Paste" from the "Edit" menu to paste at the caret point.

I Can’t Load Or Save WMA Files!

In order to load and save to WMA files, you must have support for Microsoft Windows Media Format 



7.1.  If you are trying to load a WMA file or export to WMA file and the option is grayed out, you 
probably do not have this installed.  To download and install it, please visit 
http://www.acoustica.com/plugins/index.htm .  (You do not need to restart your computer!)

If you’ve already installed WMA support, you may be trying to open a WMA with Digital Rights 
Management (DRM).  If you created this WMA file with Windows Media Player, you could recreate it 
with DRM turned off.  To turn off DRM, run Windows Media Player, choose Options from the Tool 
menu, click on "Copy Music" and make sure that "Copy Protect Music" is unchecked.  You’ll have to 
recreate the WMA.  (The old one with DRM will not work.)

I Can’t Preview Or Play Realaudio™ Files

In order to hear RealAudio files, you must have the RealAudio player.  Download the latest player from 
http://www.real.com 

Mixcraft Won’t Load The Sound. It Says That The Format Is Unsupported

There are many different types of sound file formats.  Mixcraft currently supports the Wave (.wav), 
MP3, OGG, and WMA formats.  Trying to load a .aif or .au will not work.  

In addition, Mixcraft will work with Windows Audio Compression Manager (ACM) to load compressed 
wave files.   If it is a WMA file, make sure that WMA format support is installed. and that they file does 
not have Digital Rights Management (DRM) on it.

I Edited A Sound In An Editor And It Messed Up Other Sounds!

If you had copied a sound and then edited it in an external editor in the "Edit Original" mode, it would 
have made the copies reference the same sound file.  If the length was changed or if the sound were 
altered in a time specific way, Mixcraft would not have been able to load it back in the correct way.  
Next time consider selecting the "Edit A Copy" option.

How Do I Record From The CD?

Mixcraft supports the recording of whatever sound that it is possible to record via your soundcard.  
Here are the steps to record your CD.

Recording from the CD is simple as long as your soundcard is connected to your CD. 

Click the Record button or Ctrl+R to bring up the recording window.  Then on the "Source" control, 
select "CD Player".  You are now ready to record the CD player.

 How Do I Set Mixcraft Up To Record From Memory (RAM)?
Go to the preference dialog and remove all text in the edit box labeled "Temporary Recording 
Directory".  You should see the words "(RAM)" appear.  Then click "OK" and record to your heart’s 
content.  

I’m Not Hearing Real-Time Changes Of Effects During Playback!

If you have some sounds selected, you will not hear your volume, pan, or clipboard changes during 
playback.   Once you restart playback after making a change, you will hear the changes.  

How Do I Overdub Or Record While Listening To My Other Tracks?

You need to make sure that you have done the full duplex test and have the "Overdub" checkbox 
checked on the recording window.  Depending on your soundcard’s level of full-duplex support, you 
may need to set the recording sampling rate to be the same as the playback sampling rate.



I Can’t Render To Realaudio.  It Says I Need To Download More Files!

Not everyone uses Mixcraft to create RealAudio files.  We chose to leave out the RealAudio files and 
make it an optional download.  This makes the download much smaller.  Look for the RealAudio patch 
here. 

New Tracks Are Picking Up Sound From Old Tracks.

Your new audio tracks are picking up remnants of other tracks.  Your microphone or input device is 
picking up the output from your speakers.  Try using headphones.  If that doesn’t work, your 
soundcard may have some touchy circuitry.  Go to your mixer's recording settings and make sure that 
only the devices you are interested in recording are set.

 Recording Is Not Working!

You’re mixing sounds great, but you can’t record anything!!!  There can be many reasons why this is 
not working.  Recording tips …

1. Your microphone is not plugged in to the right hole in the back of your soundcard. Sometimes it 
happens. ☺  

2. You’re trying to record on your CD but nothing is happening.  Make sure that your soundcard 
has a connection to your CD player.  This is usually an internal cable.

3. Another problem for not recording is related to the Win95/98/NT audio mixer.

� Double click the speaker icon on the lower right of your Window’s taskbar.

� Select "Properties" from the Options menu.

� Select "Adjust volume for recording" radio button.

� Make sure all the checkboxes are checked in the window entitled "Show the following 
volume controls" and press the "OK" button.

� Make sure that the device you are trying to record is selected and the slider is up.

� For example, if you are trying to record the CD,  make sure the checkbox enabled 
"Select" in the "CD Audio" panel is checked, then adjust the slider to about 75%.

� Make sure that the overall "Recording" balance on the very left is also set at 50%. (On 
many systems, you cannot adjust this anyhow.)

� Go back to Mixcraft and start recording!

What Are These CD Track Marker Things?

Track markers can be used to help organize your session.  But they can also be used in conjunction 
with a multi-WAV, MP3 or WMA mix down of when you burn a CD.  What’s that you say?  Lets say you 
created this 60 minute CD audio masterpiece that has 10 sections.  You invite your friend over and tell 
him to "listen to this one part."  You spend 15 minutes trying to fast forward to the right spot and your 
friend loses interest!  Wouldn’t it have been better to just seek to track #8 ,for example?  Thus, you can 
place a marker at the exact spot and select the "CD Track" checkbox.  When you do a multi-WAV save, 
it will create multiple WAV files based on these "CD Track" markers.  Then, use your cd burning 
software and drag in the new files!  Or, it will use the track markers when you burn directly in the 
software.

I Can’t Render To Realaudio™ Files!  It’s Grayed Out!

Realaudio is now a separate download in some cases.  You can download the Realaudio plugin for 
Mixcraft at http://www.acoustica.com/plugins/index.htm 



How To Disable Certain VST Or DirectX Effects From Loading

Mixcraft has 2 files, which allow you to exclude troublesome effects.  These files are located in your 
Mixcraft directory, which defaults to C:\Program Files\Acoustica Mixcraft\

DXIgnore.ini - DirectX effect ignore list

VSTIgnore.ini                - VST effect ignore list 

Simply open or double click the file and then add the name of the effect and set = 1.  For example,  if 
you had an effect called ‘Digital Media StudioDenoiser’ that you didn’t want the software to load, you 
would enter

Digital Media StudioDenoiser=1

Save the ignore file and restart Mixcraft and the effect will not be loaded.   For VST effects, you will 
need to use the name of the dll such as SuperDuperReverb.dll=1

The VST Or DirectX Effect Sounds Choppy And Is Breaking Up
If you have added a DirectX effect that does time stretching, it could sound choppy.  Some DirectX 
effects are designed for single sound operations.  Mixcraft applies effects to entire tracks and does not 
handle these kinds of effects as you might expect.  (Look for a future version of Mixcraft to handle time 
stretching natively.)

I Am Having Burn Failures
Here are some things to do to troubleshoot a burn failure.

� Try a burn in ‘Test Mode’ first.

� Try a different blank CD (Make sure its not full or scratched)

� Try a different blank CD from a different manufacturer.

� Try burning at a slower speed, especially if your CD recorder does not have ‘Burn Proof’.

� Try checking the option to ‘Convert To WAV First.’

� If you have more than one CD or DVD recorder, try switching to the other recorder.

� If you have Windows XP, try switching to IMAPI by quitting Mixcraft and restarting it by clicking 
the Window’s Start button followed by clicking "Program Files" followed by clicking "Acoustica 
Mixcraft" followed by clicking "Config" followed by clicking "Use IMAPI"   (Try the burn again 
when in IMAPI mode.)

� Try burning a short sound just to verify that CD recorder can still burn and is not defective.

� Try burning with another program such as Windows Media Player to verify that your CD 
recorder is not defective or having some kind of system conflict.

CD/DVD Recorder Is Not Supported!
If you click "Burn CD" and it says that it cannot find a supported CD or DVD recorder, it means that 
Mixcraft cannot support it!  Look for a new version with updated CD/DVD recorder support. 

Also, if you have another program that can burn CDs without any space between tracks, you can mix it 
down to multiple WAV files and then import those WAV files into your burning software!



Hey, I Can’t Even Find My Problem In This Section!

Start your Internet browser and go to http://www.acoustica.com/support.htm for the latest help.  You will 
even find some animated tutorials on the most common problems!  If it’s not on the website, you can 
request a support request from our online help form at to http://www.acoustica.com/support.htm !  


